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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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WinCC/DataMonitor Installation Notes 1
1.1 Installation Requirements

Introduction             
Certain hardware and software configuration requirements must be fulfilled for installation.

 

 Note

A DataMonitor server cannot be operated on a WinCC client without a project of its own.

Only use a DataMonitor server on a computer which is not operated in WinCC ServiceMode.
 

Hardware requirements
To work with WinCC/DataMonitor efficiently, select a system that meets the recommended 
specifications for an optimum configuration.

DataMonitor server

  Minimum Recommended
DataMonitor 
server on 
WinCC server 
for more than 
10 clients

CPU Intel Pentium 4; 2.2 GHz Dual-Core; > 2.2 GHz
Working memory 2 GB > 2 GB

DataMonitor 
server on 
WinCC server 
with WinCC 
project in 
Runtime

CPU Intel Pentium III; 1 GHz Server: Intel Pentium 4, 2 GHz
Working memory 2 GB > 2 GB

DataMonitor 
server on 
WinCC server

CPU Intel Pentium III; 1 GHz Server: Intel Pentium 4, 2 GHz
Working memory 1 GB > 1 GB

DataMonitor 
server on 
WinCC single-
user system or 
WinCC client 
with its own 
project

CPU Intel Pentium III; 1 GHz Server: Intel Pentium 4, 2 GHz
Working memory 512 MB 1 GB
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DataMonitor client

 Minimum Recommended
CPU Intel Pentium II; 300  MHz Intel Pentium III; 1 GHz
Working memory 256 MB 512 MB

Software requirements
For the installation, certain requirements concerning operating system and software 
configuration must be met.

DataMonitor server on WinCC server 

Operating system Software
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2
Windows Server 2008 Standard SP2 32-bit
Windows Server 2008 R2 Standard SP1 64-bit

Internet Explorer V7.0 and higher
WinCC Basic System V7.0 SP3 or WinCC Fileserver V7.0 SP3

If you want to publish Intranet information, the following is required:

● A network-capable computer with a LAN connection

● A system that converts computer names into IP addresses (IP = Internet Protocol). This 
step allows users to use "alias names" instead of IP addresses when connecting to your 
server.

If you want to publish information in the Internet, the following is required:

● An Internet connection and an IP address from your Internet service provider (ISP). You 
can only publish information in the Internet, if you have a connection to the Internet provided 
by the ISP.

● A network adapter that is suitable for connecting to the Internet.

● A DNS registration for your IP address. This step allows users to use "alias names" instead 
of IP addresses when connecting to your server.

DataMonitor server on WinCC single-user system or WinCC client with its own project

Operating system Software
Windows XP Professional SP3 (max. 3 clients)
Windows 7 Ultimate SP1 32-bit (max. 3 clients)
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2
Windows Server 2008 SP2 Standard 32-bit and 64-bit
Windows Server 2008 R2 Standard SP1 64-bit

Internet Explorer as of V7.0
WinCC Basic System V7.0 SP3 or WinCC Fileserver V7.0 SP3
For the components "Excel Workbook Wizard" 
and "Excel Workbook": 
Microsoft Office 2003 SP3, Microsoft Office 2007 SP2 
and Microsoft Office 2010 in the 32-bit version

You also need access to the Intranet/Internet or a TCP/IP connection to the Web client.
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DataMonitor client

Operating system Software
Windows XP Professional SP3
Windows 7 SP1 32-bit
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2 
Windows Server 2008 Standard SP2 32-bit
Windows Server 2008 R2 Standard SP1 64-bit
Via MS Terminal Services, also other operating systems 
such as WinCE, Win95

Internet Explorer as of V7.0
For the components "Excel Workbook Wizard" 
and "Excel Workbook": 
Microsoft Office 2003 SP3, Microsoft Office 2007 SP2 
and Microsoft Office 2010 in the 32-bit version

You also need access to the Intranet / Internet or a TCP/IP connection to the Web server. 
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1.2 User rights for installing the DataMonitor client

Introduction       
You can install the DataMonitor client as follows: 

● Installation from the product DVD
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via the Intranet/Internet
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation using the group policy-based software distribution in networks
This can be done without any user interaction and using the Windows user permissions of 
the current user.

Windows user permissions required for installation and initial logon of the client
Depending on the operating system, specific minimum user rights are required to install the 
DataMonitor client via Intranet/Internet. 

After installation, the client must log in with the following user identification for initial registration 
on the DataMonitor server:

● Under a user identification with Windows user rights higher or equal to those defined by 
the user identification that was given for the installation.

The connections must be established successfully. The subsequent logins can then be 
performed under a different Windows user authorization with possibly limited rights.

Operating system Required minimum user permission
Windows Server 2003/ Server 2008 "Administrators"
Windows XP Professional "Administrators"
Windows 7 "Administrators"

Installing the DataMonitor client with limited Windows user rights 
Using Microsoft Windows Installer technology (MSI), DataMonitor clients from Version V6.0 
SP1 can also be installed with limited Windows user permissions, i.e. permissions other than 
"Power user" or "Administrator". 

This procedure can be set during the installation using the group policy based software 
distribution in networks.

Even the add-ins and plug-ins for the DataMonitor client can be installed in this way. The 
minimum user permissions described above are also required to install plug-ins created with 
WinCC Plug-In Builder.

Using MSI technology, it is also possible to install the DataMonitor client for a configured group 
of users or computers.

Installation for a configured group of users or computers

The following is possible with the Microsoft Systems Management Server or a group policy on 
a Domain Controller:
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● The installation for a group of users or computers configured by the administrator

– To do this, the "WinCCDataMonitorClient.msi" MSI file is published on the domain 
controller and then released for a user group. The installation is then performed 
according to the configuration of the group policy based software distribution either 
during login of the defined users or when the computer is started.  
Windows Server 2003 can be used as operating system on the domain controller.

– When using a Microsoft Systems Management Server, the installation is configured by 
the administrator, triggered and executed when the relevant computer boots. Additional 
information on Microsoft Systems Management Server is available in the Internet on the 
Microsoft Homepage.

Group policy based software distribution

The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with a higher level of rights. This enables installations to be performed for which the Windows 
user has no permission. Applications which require installations with a higher permission are 
referred to as "privileged installations" in MSI technology. Installation of these applications is 
possible when a Windows user is assigned the "Always install with elevated privileges" 
permission. 

In order to use the group policy-based software distribution, a group policy is created on the 
domain controller and assigned to the distributing software or published using Active Directory. 

● Assignment: The software distribution can be assigned to a user or a computer. In this 
case, the software to be distributed is automatically installed when the user logs in or the 
computer is started.

● Publication: The software distribution can be published for single users. In this case, when 
the user logs onto the client computer, the software to be distributed appears in a dialog 
and can be selected for installation.

Installation without user interaction
During installation of the DataMonitor client, the user is normally prompted to enter information, 
such as the target directories, agreement to the software licensing conditions or to the 
components to be installed. Using a configuration file, installation can be performed via a 
network without user interaction. The required path specification and user information are 
provided in the "options.ini" configuration file. The file must be in the same folder as the 
DataMonitor client setup. 
This installation procedure is advantageous when using the group-policy-based software 
distribution.  

Installation from the product DVD requires user interaction. 

The settings predefined in the table are used under the following conditions: 

● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the client registry, for example due to another installed SIMATIC HMI product.

● The installation is performed via the group policy based software distribution with 
assignment to the computer.
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Information Parameters
Target directory for DataMonitor client INSTALLDIR=" <syspath1>\Siemens\WinCC"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameters result from the settings in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion" :

 - "<syspath1>" corresponds to the key "ProgramFilesDir" for example "C:\\Program Files"

 - "<syspath2>" corresponds to the key "CommonFilesDir", for example "C:\\Program Files\
\Common Files"

Example of a "options.ini" configuration file     

The configuration file specifies the user information and the target directories. In this example, 
only the standard language "English" is installed. If you want to install an additional language, 
assign the value "1" to the parameter, for example "DEU=1".

[USERINFO]
USER=Integration 
COMPANYNAME=Siemens AG
 
[INSTALLPATH]
COMMONDIR=" C:\Program Files\Common Files\Siemens " 
INSTALLDIR=" C:\Program Files\Siemens\WinCC "
 
[FEATURES]
DEU=0
FRA=0
ITA=0
ESP=0

WinCC/DataMonitor Installation Notes
1.2 User rights for installing the DataMonitor client

WinCC/DataMonitor
12 System Manual, 02/2013, A5E32316056-AA



1.3 Installing the Internet Information Service (IIS)

Settings
Before installing the DataMonitor server, you must first install the Internet Information Service 
(IIS). You specify the settings for the DataMonitor server during installation.

Activate the following settings:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW services > General HTTP features:

– Standard document

– Static content

● WWW services > Application development features:

– .NET extendibility

– ASP

– ASP.NET

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Requirement filtering

– Standard authentication

– Windows authentication

 
 

 Note

If the logging functions are active with IIS, the log files must be monitored and deleted, if 
necessary. The event views should be configured so that the log files do not become too 
large.
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Requirements
● To do this, you must have administrator rights.

Procedure
1. Insert the Windows CD-ROM into the drive.

2. In the Windows start menu, select the entry "Settings > Control Panel" and click on the 
"Software" symbol.

3. Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components".

4. Activate the settings specified above.
You can also use the command line "Start > Run > cmd" to install the IIS components 
located on the installation CD:
pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
Metabase;IIS-WMICompatibility

5. Close the dialog box with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.
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1.4 Installing the DataMonitor server and client

Introduction     
This chapter describes the installation of the DataMonitor server and DataMonitor client.

Installation on the DataMonitor client depends on the DataMonitor tool used.

DataMonitor server scope of installation
A DataMonitor server is installed and set up as the web server to enable WinCC/DataMonitor 
to be used. 

This installation allows you to access the WinCC runtime archive using "Trends & Alarms".

Only "Webcenter" and "Trends & Alarms" are installed on computer with a WinCC file server, 
used for example as a long-term archive server, as the other components require WinCC 
Runtime. "Webcenter" and "Trends & Alarms" install all the required components. 

 

 Note

The Microsoft Management Console must not be running when you install DataMonitor under 
Windows XP, the Administration Tools Pack will otherwise not be included in the installation.

 

Installation sequence for the web server for Windows 7 and Windows XP
If you are installing a web server on a computer that is running Windows 7 or Windows XP, 
comply with the following installation sequence:

1. Install the Internet Information Service (IIS).

2. Install the SQL Server.

If this sequence is not complied with, error messages may be reported when DataMonitor 
reports are opened.

In this happens, correct the problem as follows:

1. Start the "Web Configurator" in the Windows Start menu by selecting "SIMATIC > WinCC 
> Web Configurator" and configure the Web server.

2. Start the Security Control in the Windows start menu by selecting "Programs  > Siemens 
Automation > Security Control" and configure the security settings.

DataMonitor client installation conditions
You need not install the DataMonitor client if you only want to use "Webcenter" and "Trends 
and Alarms".

You can install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook" individually 
under "Reports/Download area" on the DataMonitor start page for the "Reports". "Excel 
Workbook" requires "Microsoft Excel 2010", "Microsoft Excel 2003 SP3" with installed hotfix 
KB907417 or "Office Excel 2007". The hotfix KB907417 is available as an "Extensibility update" 
from the "Download area".
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Depending on the operating system, specific user rights may be required for installing the 
DataMonitor client. For additional information on this, see "User rights for installing the 
DataMonitor client".

 

 Note
Downloading the client setup

To save the client setup on the client computer, select the "Save" option when downloading 
the client software from the DataMonitor server. It is recommended to save the Setup file 
because, in the event of a restart of the client computer being necessary, the Setup need not 
be downloaded again. 

If the DataMonitor client has already been installed from DVD and you want to install an 
updated version of the client via the Intranet/Internet, you must save the client setup on the 
target computer.

 

 
 

 Note
Client installation on a DataMonitor server

Proceed as follows if you also wish to install the DataMonitor client or WebNavigator client 
on a DataMonitor server: 

Use the Services Manager in Windows to set the start type of the "CCArchiveConnMon" 
service to manual and then restart the computer. You can then install the client. Ensure that 
no WebNavigator clients or DataMonitor clients access the server during installation. When 
the installation is completed successfully, the start type of the "CCArchiveConnMon" service 
must be switched back to automatic.

 

Requirement
● The DataMonitor server requires Internet Information Services (IIS).

● The DataMonitor server requires the WinCC configuration data.

● You need Windows "Administrator" rights to install the DataMonitor server.

Procedure
1. Insert the WinCC DVD into the DVD drive.

2. If the automatic execution of an autorun file is activated, after a few seconds the setup 
program starts automatically.

3. The setup can also be started manually in case the installation is performed from a network 
drive or the autorun function has been disabled.
From the Windows XP Start menu, select the "Settings > Control Panel > Software" option 
and click the "Add New Programs" icon. Then select the required installation medium.

4. The setup program is started.

5. To install, click the text "Install Software".
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6. In the following dialog, select the component "DataMonitor Server V7.2" or "DataMonitor 
Client V7.2"

7. Follow the instructions of the setup program.
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1.5 Licensing

DataMonitor client
No license is required for the DataMonitor client.

DataMonitor server 
Licenses must be installed on the DataMonitor server for the DataMonitor clients. The license 
check is different for the following function groups. 

● "Excel Workbooks" 
A "WinCC DataMonitor" license is required on the server computer for each DataMonitor 
client.

● "Webcenter", "Trends & Alarms", "Reports"
For "Webcenter", the license count depends on the number of connections rather than the 
number of clients. 

The following table shows the number of possible clients based on the function group and 
license.

License Excel Workbooks Webcenter, Trends & Alarms, Reports
1 Client 1 3
3 Clients 3 6
10 Clients 10 20
25 Clients 25 50
50 Clients 50 100

Example
With a "3 Clients" license, the following users can log on simultaneously:

● 3 users of the "Excel Workbooks" function group

● 6 users of the "Webcenter", "Trends & Alarms", "Reports" function group

Operation without valid license 
If no license is available, DataMonitor displays a page requiring acknowledgement indicating 
the missing license at start-up. 

● Click the "OK" button to acknowledge the notice. The start page of the DataMonitor is 
displayed.

● Check the existing licenses. If necessary, install the required licenses.
 

  Note

The connection to the DataMonitor server will be maintained if the user closes the 
DataMonitor start page without logging off with the "Log off" button. The license will remain 
in use and only be released after approximately 20 minutes.
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WinCC/DataMonitor Release Notes 2
2.1 Release notes

Contents
These release notes contain important instructions.

The statements in these release notes are more binding than the instructions in the manuals 
and in the online help.

Please read these release notes carefully as they contain useful information.
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2.2 Notes about DataMonitor

Notes about DataMonitor
These release notes contain important information.

The statements in these release notes take precedence over information provided in the 
manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Opening Excel workbooks on a computer not connected to the Internet
If you want to use the DataMonitor client on a computer not connected to the Internet, you 
must deactivate certificate checking. To do this, follow these steps:

● Open Internet Explorer.

● Select the "Internet Options" command from the "Tools" menu.

● Click "Advanced".

● In the "Security" section, deactivate the setting "Check for publisher's certificate revocation".

Excel workbook functions and print jobs after deactivating and activating WinCC Runtime
If you deactivate WinCC Runtime and then reactivate it, you also need to restart the Web 
application.

Excel workbook: volume of requested data for archived values
Although you can limit the requested data volume with the "Data resolution" property, all data 
of the defined time period is initially used internally. This may have the result that the internal 
system limit is reached. Use compression archives to limit the data volume.

Excel workbook: Tag selection for event-driven print jobs and Excel Workbooks
As of WinCC V7.2, you can limit display the available variables for the selection of tags using 
a filter. For example, the filter setting "N*" shows all tags that start with "N".

WinCCViewerRT replaces Process Screens
As of WinCC V7.0 SP2, the web viewer "WinCCViewerRT" is used as the "View Only Client" 
for monitoring and navigating WinCC process pictures.

Web Client: Display of ActiveX controls in Internet Explorer       
ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC 
controls are not displayed correctly in Internet Explorer on a Web client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable 
the ActiveX controls only for the "Trusted sites" zone.
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When you have finished making your changes, verify that the restricted security settings still 
apply for the other zones in order to retain the protection of protecting Internet Explorer against 
unknown ActiveX controls.

For more information, refer to the following documentation: 

● WinCC/DataMonitor: "WinCC/DataMonitor Documentation > Configuring the DataMonitor 
System > Working with the DataMonitor Client > Configuring Security Settings in Internet 
Explorer"

DataMonitor server: Remote access to WinCC file server
Remove access from one DataMonitor server to a WinCC file server is possible only if the 
firewall is disabled on the WinCC file server.

Excel workbook: Local times on DataMonitor client and DataMonitor server
Please note when requesting archive data that the local times on the server and client may 
differ if they have not been sufficiently synchronized, for example because automatic 
synchronization is not possible. 

The DataMonitor client attempts to establish the current time of the DataMonitor server when 
archive data is requested. If it succeeds, the query will be based on the server time. For the 
display of data in the Excel table, the time stamp represents the server time but in the local 
time zone of the client. 

If the query of the server time is unsuccessful, the DataMonitor client will base the time period 
of the query on its local time. An entry will also be made in the Windows event display on the 
DataMonitor client. For the display of data in the Excel table, the time stamp represents the 
client time.

Excel workbook: Client on terminal server
In the case of operation on a terminal server, an Excel Workbook client will run in a session 
of the terminal services. A maximum of only 10 Excel workbook clients can be operated; 
otherwise, MS Excel will overload the computer.

Trends & Alarms: Display of archive data after copying a project
To copy a WinCC project between computers and then display the archive data of the project 
on the target computer in "Trends & Alarms", you will first need to copy the project using the 
WinCC Project Duplicator. 

If you use Windows Explorer rather than the Project Duplicator to copy the project, the runtime 
data will not be adapted to the target computer. The computer name of the source computer 
and not that of the target computer is displayed in the archive selection in "Trends and Alarms". 
The computer name of the target computer is displayed in the selection field only after the 
archive has been reset in Alarm Logging and Tag Logging. 
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2.3 Service and Support

2.3.1 Warnings

Safety notes
This manual contains information that must be observed to ensure your personal safety and 
to prevent property damage. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety alert 
symbol. Depending on the hazard level, warnings are displayed in a descending order as 
follows:

 

 DANGER

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

 

 WARNING

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

 

 CAUTION

means that there can be slight physical injury if the corresponding safety measures are not 
followed.

 

 NOTICE

means that there can be damage to property if the corresponding safety measures are not 
followed.

 

 Note

means an undesirable result or state can occur if the corresponding instruction is not followed.
 

 Note

is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

 

If multiple levels of hazards can occur, the warning is always displayed with the highest possible 
level. If a warning with a warning triangle is to be indicate physical injury, the same warning 
may also contain information about damage to property.
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Qualified Personnel
The corresponding machine/ system may only be set up and operated with the help of this 
documentation. A device/system must only be commissioned and operated by qualified 
personnel. Qualified persons in the sense of safety instructions in this documentation stand 
for persons who are authorized to operate, earth and mark machines, system and electrical 
circuits according to safety standards.

Proper use
Please observe the following:

 

 WARNING

The machine may only be used for the application instances that have been described in the 
technical description and only in combination with third-party devices and components 
recommended and/or approved by Siemens. Smooth and safe operations demand proper 
transport, proper storage, installation and assembling as well as careful operations and 
maintenance.

 

Brands
All designations with the trademark symbol ® are registered trademarks of Siemens AG. Other 
designations in this documentation may be trademarks whose use by third parties for their own 
purposes can violate the rights of the owner.

Security information
Siemens offers IT security mechanisms for its automation and drive product portfolio in order 
to support the safe operation of the plant/machine. Our products are also continuously 
developed further with regard to IT security. We therefore recommend that you keep yourself 
informed about updates and upgrades for our products and always use the latest version of 
each product. You can find information on this at:

● http://support.automation.siemens.com (http://support.automation.siemens.com) 

You can register for a product-specific newsletter here.

For the safe operation of a plant/machine, however, it is also necessary to integrate the 
automation components into an overall IT security concept for the entire plant/machine, which 
corresponds to the state-of-the-art IT technology. You can find information on this at:

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity) 

Products used from other manufacturers should also be taken into account here.

Disclaimer of liability
We have checked the contents of the description to ensure that it matches with the hardware 
and the software it describes. Nevertheless, we cannot assume responsibility for any 
deviations that may arise. The details outlined in this description are checked regularly and 
the required corrections are done in the subsequent editions. Suggestions for improvement 
are welcomed.
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The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release 
Notes and Installation Notes has priority over that in the manuals and online help with regard 
to legal validity.

Copyright © Siemens AG 2012
Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless 
the same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG

Automation and Drives

SIMATIC Human Machine Interfaces

P.O. Box 4848

D-90327 Nuremberg, Germany

 

See also
http://support.automation.siemens.com (http://support.automation.siemens.com)

http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

2.3.2 Customer Support

Customer Support and Technical Support      
You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC 
hotline employees speak German and English. The Authorization hotline offers French, Italian 
or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service HoursMonday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request  (http://

www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:
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● http://support.automation.siemens.com/WW/view/en/16605032 (http://
support.automation.siemens.com/WW/view/en/16605032)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides extended Technical Support and is available 24 
hours every day of the week. Information on the AVC can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/21981898 (http://
support.automation.siemens.com/WW/view/en/21981898)

SIMATIC Customer Online Support 

Service and Support 
An overview of the support offering for our products is available at the following URL:

● http://www.siemens.com/automation/service&support (http://www.siemens.com/
automation/service&support)

In Product Support, for example, you will find downloads of firmware updates, service packs 
and useful utilities.

Online Help is available so that you can successfully use the Support offering. Open the Online 
Help by selecting the corresponding button on the Internet site or at the following URL:

● http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm (http://
support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm)

WinCC FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be 
found at the following URL:

● http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://
support.automation.siemens.com/WW/view/en/10805583/133000)

Searching in the Support database
The topic-related search in the Support database can be found under the following URL:

● http://www.siemens.com/automation/csi/km (http://www.siemens.de/automation/csi_en/
km)

Technical Forum
The Technical Forum supports exchange with other SIMATIC users. It is available at the 
following URL:

● http://www.siemens.com/automation/csi/forum (http://www.siemens.de/automation/csi_en/
forum)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:
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● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal)

Contact person database
To contact your local agent, search our contact database at the following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp?lang=en)

Product Information 

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:

● http://www.siemens.com/wincc (http://www.siemens.com/wincc)

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:

● http://www.siemens.com/simatic (http://www.siemens.com/simatic)

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)

Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032)

Internet: Automation Validation Card (AVC) (http://support.automation.siemens.com/WW/
view/en/21981898)

Internet: Service and Support (http://www.siemens.com/automation/service&support)

Internet: WinCC FAQs (http://support.automation.siemens.com/WW/view/en/
10805583/133000)

Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)

Internet: Support Search (http://www.siemens.de/automation/csi_en/km)

Internet: Support Online Help (http://support.automation.siemens.com/WW/support/html_76/
help/Online_Hilfe.htm)

Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal)

Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)

Internet: Information about WinCC (http://www.siemens.com/wincc)

Internet: SIMATIC Products (http://www.siemens.com/simatic)

2.3.3 Support Request
Dear customer
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In order to provide you with fast and effective support, please complete the "Support Request" 
form online on the Internet. Describe the problem in as much detail as possible. We would 
appreciate if you would provide us with all project data, so that we can reproduce the error 
situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").

Support Request form
The Support Request form is available at the following URL:   

● http://www.siemens.com/automation/support-request (http://www.siemens.com/
automation/support-request)

When filling out the report, you will be guided through several steps, which will ask about all 
required information.

A detailed description of the Support Request can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605654 (http://
support.automation.siemens.com/WW/view/en/16605654)

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.
Search for parts of the product name or enter the full product name in the correct order. 
You can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "wincc webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".

4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions".
Suggested solutions and FAQs for the selected key words are listed.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".
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6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). 
The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) 
to the Support Request.
Press "Next" to switch to step 5 "Provide contact information".

8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
You close the support request by clicking the "Send" button.
Your data will be transmitted to Customer Support and processed there.

 

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team 

See also
Internet: Error Report (http://www.siemens.com/automation/support-request)

Internet: Overview of Support Request  (http://support.automation.siemens.com/WW/view/en/
16605654)
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WinCC/DataMonitor Getting Started 3
3.1 DataMonitor

Overview   
You can display and evaluate current process states and historical data with WinCC/
DataMonitor via the Intranet/Internet. 

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor 
server makes functions available to the DataMonitor client for analysis and display of data. 
Access rights control access to the functions.

● "WinCCViewerRT":
Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only 
Client".

● "Excel Workbook":
Display of process values and archive values in an Excel table for evaluation and display 
via the web or as a print template for reports

● "Reports":
Creating reports from WinCC print jobs or from published Excel workbooks. This also allows 
for statistics and analyses of certain process data or historical data. The reports are created 
in PDF format and forwarded as e-mail if necessary.

● "Webcenter":
Central information portal for access to WinCC data via user-specific views. Clearly 
structured Webcenter pages with individual user rights for reading, writing and creating 
Webcenter pages.

● "Trends & Alarms":
For display and analysis of archived process values and alarms. The data is displayed in 
tables and diagrams on predefined Webcenter pages.

Quantity Structure
WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server. When 
using the terminal services, up to 25 DataMonitor clients are released per terminal services 
server. 
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3.2 Preparations

Introduction
For the Getting Started, you will implement a WinCC single user system, on which the 
DataMonitor server will be installed. To access the data and display them with the DataMonitor 
client, the client is started on the DataMonitor server.

Requirement
Please follow the Installation Notes of WinCC and WinCC/DataMonitor.

● Internet Information Service is installed.

● WinCC is installed and has been started.

● The DataMonitor server is installed.

● The DataMonitor client is installed.

● A WinCC/DataMonitor license is installed.

● Internet Explorer is installed.

Configuration steps
You have to complete the following configuration steps to set up the DataMonitor system.

1. Configure the DataMonitor system.

– Define Windows user and access rights in Windows.

– Define WinCC user and access rights in "WinCC User Administrator" for 
WinCCViewerRT and "Excel Workbook".

– Set up the web page and firewall.

– Publish WinCC pictures.

2. Start the WinCC Runtime.

3. Set up the DataMonitor client.

– Configure the security settings of the Internet Explorer.

4. Use the DataMonitor client.

– Start the Internet Explorer and enter the address of the DataMonitor server.

– Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project with the WinCCViewerRT.

– Set up WinCCViewerRT.

– Display pictures.
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3.3 Configuring the DataMonitor system

3.3.1 Defining users in Windows

3.3.1.1 User groups in Windows

Overview           
The following user groups are created automatically in Windows when the DataMonitor server 
is installed.

SIMATIC Report Administrators
Membership of the user group "SIMATIC Report Administrators" is required for extended rights, 
especially for configuration purposes. At least one user must be created and assigned to the 
"SIMATIC Report Administrators" user group.

● You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":

– Configuring connections

– Creating templates for Webcenter pages

– Creating and configuring public and private Webcenter pages

● You can also do the following as "SIMATIC Report Administrators" in "Reports":

– Configuring reports based on WinCC print jobs or Excel workbooks.

SIMATIC Report Users
Membership of the user group "SIMATIC Report Users" or of your own user group is required 
for the "Webcenter", "Trends & Alarms" and "Reports".

● You can also do the following as "SIMATIC Report Users" in the "Webcenter":

– Setting up and configuring Webcenter pages. The Webcenter pages are stored in 
different directories.

– Opening public pages

● You can also do the following as "SIMATIC Report Users" in "Reports":

– Opening reports based on WinCC print jobs or Excel workbooks.
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3.3.1.2 Defining Users and Access Rights in Windows

Introduction       
When using DataMonitor, users need different authentications. All users must be members of 
the "SIMATIC HMI" user group. For access to the WinCC database via DataMonitor, you need 
a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group.

This means you must create users with the matching user rights.

Requirement
● WinCC is installed.

● The DataMonitor server is installed.

Procedure using Windows XP as an example 
1. From the Windows Start menu choose "Settings > Control Panel".

2. Double-click the "Administration" entry.

3. Double-click the entry "Computer Management" in the "Administration" dialog.
The "Computer Management" dialog is opened.

4. Navigate to the directory "System > Local Users and Groups / Groups". In the shortcut 
menu select the entry "New user".

5. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" field.
Enter a description such as "User for DataMonitor" in the "Complete name" field.
Type the desired password into the "Password" field and then repeat it in the "Repeat 
password" field.
Create the user with "Create".
Close the "New user" dialog.

6. In the right part of the table window, click on the newly created user. In the context menu 
select the entry "Properties".
Click on the "Membership" tab.
Click "Add".

7. In the "Select groups" dialog, click the "Extended > Find now" button.

8. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI"  and "SIMATIC HMI 
VIEWER" from the list at the bottom of the dialog.
Click "OK" twice to close the dialog.

9. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI"  
and "SIMATIC HMI VIEWER" have been added to the list of memberships.
Click "OK".

10.Close the dialog "Computer Management" using the entry "File > Exit".

11.Close the dialog "Management" using the entry "File > Exit".
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Result
The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", 
"SIMATIC HMI"  and "SIMATIC HMI VIEWER" has been set up. The user can now create 
directories in the Webcenter and make connections to WinCC databases.

 

 Note

If a user wants to access remote computers via the DataMonitor server, the Windows user 
must be set up on the DataMonitor server as well as the remote servers with the same 
password.

 

3.3.2 Administering users for DataMonitor

Introduction     
For the use of certain functions on the DataMonitor client, users need authentication as 
DataMonitor user as well as authentication as WinCC user. Use one WinCC user for 
"WinCCViewerRT" and "Excel Workbook".

If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to 
log on twice. You have two alternatives to only log on once:

● The DataMonitor user and the WinCC user have identical names and passwords.
The user must be configured in Windows and in WinCC and added to the "SIMATIC HMI" 
and "SIMATIC HMI VIEWER" user groups.

● SIMATIC logon allows the central administration of users.
In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must 
also be added to the user group "SIMATIC HMI VIEWER".
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Procedure
1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select 

the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select "Create User" in the "User" menu.
The "Add New User" dialog box opens.

4. Enter a name and a password with at least six characters for "Login".
Click "OK".

5. Select the newly created user.
Select the "Web Navigator" check box in the table window.
The "Web Options" area is displayed.

6. Click the "..." button to create a start picture.
Select a start picture, such as "start.Pd_".
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7. Check the selected language and change this setting if desired via the "..." button. Only 
languages that have been installed in WinCC are available for selection.

8. The user needs at least the authorization no.1002 "Web Access - monitoring only".
Double-click the "Release" column in the row of the authorization.
A red dot indicates the activated authorization.

9. Close the User Administrator.

3.3.3 Configuring the DataMonitor web page

Introduction     
You create the DataMonitor web page with the WinCC Web Configurator.

Requirement
● The DataMonitor server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Click the "Web 

Configurator" command in the shortcut menu.
You can also select the "Start > Programs > Siemens Automation > Option and Tools > 
HMI Tools > WinCC Web Configurator" command in the Windows Start menu.

2. The Web Configurator detects whether a configuration already exists.

– No configuration found: Activate "Create a new standard website (Standalone)". Click 
"Next".

– Configuration found: Click "Next" and check the configuration.
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3. Select "Name of the web page" and enter the name.

4. Enter the number of the port used for access in the "Port" field.

5. At "IP address", specify whether the computer is to be available on the Intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list.
Select "All not assigned" to enable Intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection 
automatically in case of a connection error. A time setting of "0 s" disables the "Automatic 
reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall.
Click "Next" if you have installed a firewall. See the following pages to find out how to set 
up a firewall.

Result
You have created the Web folder and activated the web page. When you have activated the 
firewall, use the Web Configurator to configure its settings. 

See also
Configure the firewall (Page 40)
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3.3.4 Configure the firewall

3.3.4.1 Configuring the Firewall in Windows XP/Windows 2003

Introduction       
This section describes how to activate the "HTTP" or "HTTPS" services and the procedure for 
other port settings in Windows XP or Windows 2003.

Requirement
● A default web page was created using the Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".
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Procedure for the default port
1. Click the "Windows Firewall" button in the Web Configurator.

The "Windows Firewall" dialog opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button.
The "Advanced Settings" dialog opens.
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3. Select the "Secure Web server (HTTPS)" or "Web server (HTTP)" check box.
Click the "Edit" button to display the current service settings for the web server.

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator. The server configuration is completed.
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Procedure for other port settings
Customize the Windows Firewall settings as follows if you are not using the default port.

1. Click the "Windows Firewall" button in the Web Configurator. The "Windows Firewall" dialog 
opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button. The "Advanced 
Settings" dialog opens.

3. Click "Add" in the " Advanced Settings" dialog.
The "Service Settings" dialog opens.
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4. Specify the web server settings:

– Web server name in the "Service description" field

– Name or IP address

– External and internal port number for this service

– "TCP" service

Confirm with "OK".

5. Activate the web server you created in the "Advanced Settings" dialog.

6. Close all Windows dialogs with "OK".

7. Click "Finish" in the Web Configurator. The server configuration is completed.

3.3.4.2 Configuring the Firewall in Windows 7/Windows 2008

Introduction       
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 
7 or Windows 2008.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows 2008: Click "Allow a program to communicate through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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3.3.5 How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
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3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.
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6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list.

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".
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3.4 Working with the DataMonitor client

3.4.1 Configuring security settings in Internet Explorer

Introduction     
For full functionality on the DataMonitor client, adapt the security settings in the Internet 
Explorer. 

Requirement
● Internet Explorer is installed.

Procedure
1. Click "Tools > "Internet Options" in the Internet Explorer.

This will open the "Internet Options" dialog.

2. Select the "Security" tab.

3. Select the "Trusted Sites" icon and click the "Sites" button.
The "Trusted Sites" dialog opens.

4. Enter the address of the DataMonitor server in the "Add this website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. Deactivate the "Require server verification (https:) for all sites in this zone" check box.
Click "Add".
Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level".
Click "Adapt Level" in the next dialog.
The "Security settings" dialog box is opened. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".

Result
The necessary settings in the Internet Explorer of the DataMonitor client are configured.
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User authentication: Activated setting "Automatic logon with current user name and password" in 
Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet 
Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User 
Authentication" > Logon", this can lead to unexpected behavior under the following 
requirements.

Requirement
● The "Automatic logon with current user name and password" The setting is activated in 

Internet Explorer.

● The user logs onto the DataMonitor client as a WinCC user who is not configured in the 
user groups on the DataMonitor server.

● The user is logged onto the computer with a Windows logon that is set up as a user name 
on the DataMonitor server.

Behavior
1. The DataMonitor server does not recognize the WinCC user name the user has used to 

log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.

2. Internet Explorer automatically starts a new logon using the current Windows logon as user 
name.

3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and 
accepts the logon for this user.

4. The user is logged on but not with the DataMonitor user name the user has entered. The 
current DataMonitor user is not displayed.

Recommendation
Disable the "Automatic logon with current user name and password" setting. 

Use the setting only when there is a clear distinction between Windows logon and DataMonitor 
user name.

3.4.2 DataMonitor start page on the DataMonitor client

Overview         
You start the DataMonitor client on a standalone computer or on a DataMonitor server. The 
start page of the DataMonitor summarizes the functions of the DataMonitor: 

● "Reports":
Creation and output of analysis results and process data in print jobs and published Excel 
workbooks.

● "Webcenter":
Creation of Webcenter pages for the display of archived data.
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● "Trends & Alarms":
Display of alarms and process values from archives in tables and diagrams.

● "Administration"
Configuration of connections and management of users, archives and pictures.

Requirement
● The user is created in WinCC.

● The user must be a member of the Windows user group "SIMATIC Report Administrators" 
or "SIMATIC Report Users" .

● The WinCC project on the DataMonitor server is in runtime.

Procedure
1. Start the Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL.
Confirm the entry with "Enter".
The log-in dialog is opened.

3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result
The start page with the DataMonitor functions will be displayed. The use of the functions 
depends on the access right of the user. 
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General Operations of the DataMonitor Client
● Select the desired interface language from the selection field in the header.

● Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary.
Click . 
To show the header line again, click on the symbol .

● In order to log off from the DataMonitor server, click on the "Log off" link.
Exit Internet Explorer to free-up the used license immediately.

See also
Working with reports (Page 210)

Working with trends and alarms (Page 180)

Working with the Webcenter (Page 150)
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3.5 Working with WinCCViewerRT

3.5.1 Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

Requirement
● On the server

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring 
only".

● On the client

– The DataMonitor client is installed.
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Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: "http://<Servername>" or "http://<IP-Adresse>"

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions
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5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the DataMonitor server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is available in the folder "Documents and Settings\User\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

 

 Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.
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3.5.2 Displaying pictures

Requirement       
● A WinCC/DataMonitor license is installed on the DataMonitor server.

● The WinCC project on the DataMonitor server is in runtime.

● The WinCC pictures are configured and published for web access.

● The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".

● WinCCViewerRT is configured on the DataMonitor client.

Procedure
1. Start WinCCViewerRT in the Windows Start menu with "Start > Programs > Siemens 

Automation > Options and Tools > HMI Tools".

2. Log on to the DataMonitor server:

– A login dialog is not displayed if the user name and password are set in the 
WinCCViewerRT configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC 
user. Click "OK".

3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Click "OK". 
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The pictures of 
WinCC project are displayed. 

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 129)".

The <F5> key triggers a reselection of WinCCViewerRT.
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3.6 Use of DataMonitor

3.6.1 Create connection and set up language

Introduction     
For access of the DataMonitor client to runtime data and archived data configure connections 
to the WinCC databases in the "Webcenter". Set up a connection for each data source, e.g. 
to WinCC server or CAS. You need the configured connections for Webcenter pages and 
"Trends & Alarms". 

Requirement
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● For access to the WinCC database via DataMonitor, a Windows user with password is 
created who is a member of the "SIMATIC HMI VIEWER" user group.

Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click the "Connection Administration" tab.
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3. Select the option "New Connection". After the new installation, no selection is possible in 
the "Connection" field, as no connections have been configured yet.

4. Select the language that corresponds with the linguistic region of the server or archive to 
be linked in "Linguistic Region". The setting ensures that special national characters are 
displayed correctly. 

5. Enter a name in the "Connection Name" field, such as "WinCC1_Runtime". The name 
should include a reference to the selected connection type. Do not use any blank spaces 
or special characters.

6. Enter the computer name on which the archive backup data are stored.
As an alternative, select the name of the computer using the "Find" button.

7. Enter the Windows user with password for the connection with the WinCC database.

8. Select the connection type to the WinCC data:

– "Swapped-out WinCC archive". Additional steps are necessary to access data on 
swapped archives. More information is available under "Connecting or separating 
swapped archives (Page 158)".

– "WinCC Runtime". Only the open single segment of the Runtime database is used.

– "CAS". The WinCC data of the central archive server are used.

– "WinCC Runtime + all segments". The open single segment and all other connected 
segments of the Runtime database are used.

9. Select the database for the connection type:

– "Swapped-out WinCC archive": Click "Display database" or select the archive from the 
list.

– "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC 
project. As an alternative, select the name of the database using the "Find" button.

– "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as 
database.

10.Activate "Automatic adaptation of RT database" so that the database name is adjusted in 
the connection administration during a segment change.

11.Click the "Create" button.

Result
The connection to the data source is created and can be selected in the "Connection" field of 
the connection administration. 
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3.6.2 Displaying process values and messages via "Trends and Alarms"

3.6.2.1 Displaying process values in a table

Introduction         
Use "Trends & Alarms" to display archived process values in a table.

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Process Value Table" tab.
The Web part "Process Value Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.
The archive tags available via this connection will be displayed. 
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range". 

8. Specify the number of decimal points in the area "Representation of decimal points".

9. In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.

Result
The values of the archive tags and the quality code are output in the process value table. 
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If the manual entry of archive values is allowed during runtime, the modified or newly created 
values are identified as such. There is an "m" in a separate column to show a manual entry of 
the archive value.

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

3.6.2.2 Displaying process values in a diagram

Introduction         
Use "Trends & Alarms" to display archived process values in trends. 

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Trend (Process Values)" tab. The Web part "Trend (process values)" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed.
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2.
The archive tags are listed in the area "Current selection".

7. In the section "Current selection", you specify for the individual archive tag:

– Color of time axis and value axis

– Trend presentation type

8. In the section "Value axis editor", you can activate the automatic scaling for the different 
value axes or you can assign a minimum and maximum value to each axis.

9. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range".

10.In the section "Diagram settings", you define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

11.Activate the option "Show legend" to display the legend.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the archive tags. 

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Enlarge the presentation and diagram range left or right of the center line. 
Restore the original view.
Exporting values of the displayed diagrams in CSV format
Changing the settings of the Web part.

 

3.6.2.3 Displaying messages in the alarm table

Introduction         
Use "Trends & Alarms" to display alarms in an alarm table. 
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Alarm Table" tab.
The web part "Alarm Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.

8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The 
setting is necessary if you select a connection to swapped archives that include archives 
of several WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. 
Enter the filter condition for all columns in the "Extended Filter" field. 
For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages".
Click  to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The messages are output in a table.

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.
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3.6.3 Displaying process values in an Excel workbook

3.6.3.1 Excel workbook

Overview         
With the Excel add-In "Excel Workbook" you can display the following data of the WinCC 
project in an Excel workbook on the DataMonitor client:

● Alarms

● Values of process tags and archive tags

● Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e. g. as average value calculation 
or diagram representation. The created Excel workbooks are made available as templates for 
"Reports" and as report tools.

Requirement
● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 

and "Excel Workbook" on the DataMonitor client.
For "Excel Workbook" you need "Microsoft Excel 2003 SP3" with installed hotfix KB907417 
or "Office Excel 2007". The hotfix KB907417 is available as "Extensibility Update" in the 
Download area.

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
"Excel Workbook". This requires that you either take the data from an XML file or from a local 
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WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard" . A 
separation between process and evaluation is possible with the XML file. 

● A WinCC project is open on the DataMonitor server.
The XML file is generated with the "Export Configuration Data" function. 
Then transfer the XML file to a computer with Microsoft Excel. 
Configure the process data display in the workbook. 
Afterwards, transfer the workbook to a DataMonitor client that displays the process data 
online.

● To accept the data of the WinCC project online, configure directly on the WinCC server or 
on a WinCC client with an online connection to the respective WinCC server.

● Import the data into an Excel workbook using the "Excel Workbook Wizard".
Then configure the display of alarms and tag values.

 

  Note

If you rename a table in an Excel workbook, the configuration data of the table will be lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During 
online display with "Excel Workbook" you may experience considerable delays in updating 
when there is a large number of tags.

 

3.6.3.2 Configuring the Excel workbook

Applying data from WinCC project

Introduction     
You need the WinCC configuration data for the configuration of Excel workbooks. This means 
you apply the data from a local WinCC project during configuration in the "Excel Workbook 
Wizard" . 
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Requirement
● Server computer

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook" is installed.

– The DataMonitor server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– If you are using Excel 2007, you are only permitted to use Excel files with the extensions 
"XLS, "XLSX, "XLSB", and "XLSM".

– If you also use Excel 2003, you will have to switch on the compatibility mode in Excel 
2007.

Procedure
1. Open an empty Excel workbook.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" field is 
shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The dialog "Add / delete tags" will open.
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Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports".

 

 Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/
320369/en (http://support.microsoft.com/kb/320369/en) 

 

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

Applying data from a configuration file

Introduction     
You can create reports without connection to the WinCC server.

Configuration steps:
● Create a configuration file on the server.

● Configure data access with the configuration file.

● You can also configure the data access of a dedicated Web server / WinCC client.
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Requirement
● Server computer

– The DataMonitor server is installed.

– The online tags of the WinCC project are part of one tag group or one structure type.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– If you are using Excel 2007, you are only permitted to use Excel files with the extensions 
"XLS, "XLSX, "XLSB", and "XLSM".

– If you also use Excel 2003, you will have to switch on the compatibility mode in Excel 
2007.

Creating a configuration file on the server 
1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer.

Open the menu command "Export Configuration Data" in the shortcut menu.

2. Specify the data to be exported in the "Export configuration data" dialog. 
If you do not want to create the online tags in one tag group or one structure type, use the 
"Without structure (fast export)" option for the export.

3. Specify the path and the name of the XML file.

4. Click "Export". An XML file is generated.

5. If no Excel installation exists on the server, transfer the XML file to another computer, on 
which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file
1. Open an empty Excel workbook on the computer with Excel.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next".

3. Navigate to the desired XML file.

4. Click "Next". The dialog "Add / delete tags" will open.

Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports". 
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Configuring data access of a dedicated Web server / WinCC client via XML file
If you want to display the project data from a dedicated Web server / WinCC client in the Excel 
workbook, you need to observe the following when configuring the Excel workbook via an XML 
file:

● The XML file now includes the data of subordinate servers whose packages are located on 
the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor 
server / WinCC client can take several minutes, depending on the size of the package.

● This XML file must be available on the Excel configuration computer. Enter the server prefix 
when importing the configuration data in the "Excel Workbook Wizard".

● If you configure the data display in the Excel workbook on the WinCC client in the WinCC 
project, you do not have to specify a server prefix. The server prefix is automatically used 
when data is inserted from the package.

 

  Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you 

must also select "Chinese (PRC)" as the primary processing language in the "Microsoft 
Office Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/
kb/320369/en (http://support.microsoft.com/kb/320369/en) 

 

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

Publishing the Excel workbook (Page 84)

Configuring the display of tag values

Introduction       
This chapter describes how to configure the display of tag values.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete tags" is open.

WinCC/DataMonitor Getting Started
3.6 Use of DataMonitor

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 75

http://support.microsoft.com/kb/320369/en


Procedure
1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
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5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

6. Enter the name and password of a WinCC user in the "Server setting" dialog.
To avoid an additional login during online display of process data, enable "Activate 
automatic login". 
Confirm your entries with "OK".

7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Tag properties" will be opened.

8. Set the properties for display in the table, for example, the update cycle or the display of 
time stamp and quality code.

9. To apply the set update cycle to all tags, activate "Save as default".
Settings in the areas "Display in sheet" and "Additional data" do not apply to all tags.
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10.Confirm your entries. If necessary, repeat the previous steps to display additional online 
tags. Multiple selection of tags is also possible in the tag list.

11.Click "Next" to display archive tags and alarms.
Additional information is available under "Configuring display of archive tags (Page 78)" 
and "Configuring display of alarms (Page 81)".

Result
The display of tag values is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text "OV" in tag values stands for online tags. In the comments, the source of the 
displayed values is shown in the format "WDWO_<number>_<tagname>". 

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data.
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.
Tags with local computer updating are not supported

In multiple station projects, you can activate the "Computer-local update" option in the tag 
management for internal tags. Any change of the tags only has an effect on the local computer 
in this case. This function is not supported by Excel Workbooks.

 

 

See also
Publishing the Excel workbook (Page 84)

Configuring the display of archive tags

Introduction       
This chapter describes how to configure the display of archive tags.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete archive tags" is open.
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Procedure
1. Click  in the dialog "Add/delete archive tags".

2. The tag selection dialog opens.
Select the desired archive tag. 
Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
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4. Select the archive tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Archive tag properties" will be opened.

5. Define additional properties for display in the table, for example, data resolution or time 
window of the display.

6. If you select  the option "Display manually entered values", an additional column is 
displayed. You will then see the letter "m" if an archived value was manually entered during 
runtime.

7. To save the settings, enable "Save as default". The settings in the area "Additional data" 
are not saved.

 

  Note

If you use a user-defined data resolution with a combination of "Resolution" and "Quantity 
of data", it is possible that the amount of extracted data is not correctly determined. This 
results under certain circumstances in a mismatch between the displayed values and the 
configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value 
in the input field. Even values ensure a trend-true display.

 

8. Confirm your entries.
If necessary, repeat the previous steps to display additional archive tags. Multiple selection 
of tags is also possible in the tag list.

9. Click "Next" to display alarms. For more information, refer to "Configuring display of 
alarms (Page 81)".
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Result
The display of archive tag values is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text "AV" in tag values stands for archive tags. In the comments, the source of the 
displayed values is shown in the format "WDWA_<number>_<tagname>". 

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

 

 

See also
Publishing the Excel workbook (Page 84)

Configuring the display of alarms

Introduction       
This chapter describes how to configure the display of alarms.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete alarms" is open.
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Procedure 
1. Configure the alarms in the dialog "Add/delete alarms".

2. Select the required cell in the Excel table.
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3. Click . The dialog "Alarm - properties" will be opened.

4. Define the display options for alarms in the Excel table, such as headings and insertion 
sequence of attributes.

5. Enter a filter condition in the "Filter string" field or use the selection dialog to define a filter, 
for example, to display only specific alarms.

6. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 messages.

7. Activate the desired attributes in the list. For additional information, refer to "Alarm 
attributes (Page 207)".

8. To save the setting, enable "Save as default".

9. Confirm your entries.
If necessary, repeat the previous steps to display additional alarms. Multiple selection of 
alarms is also possible in the "Alarm list".

10.Click "Next". The "Description" dialog box will open.

11.You can enter a comment if needed. This comment is displayed when selecting files 
provided for download by the DataMonitor server.
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Result
The display of alarms is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown 
in the format "WDWL_<number>_<fieldname>".

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

 

 

See also
Publishing the Excel workbook (Page 84)

Publishing the Excel workbook

Introduction
You make the configured Excel workbooks available on the DataMonitor client. The workbooks 
are published as report tool for the Intranet/Internet or used as template for "Reports". 

Requirement
● The DataMonitor server is installed on the computer.

● The display of tag values, archive values and alarms is configured.

● The "Description" dialog is open in the "Excel Workbook Wizard".
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Procedure
1. You make the workbooks available in the "Description" dialog.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under 
"Report tools" in "Reports".
If you click "Template", the Excel workbook is made available on the DataMonitor client as 
template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure
You upload the Excel workbooks on the DataMonitor client. Additional information is available 
under "Making Excel workbooks available as template (Page 210)" and "Making Excel 
workbooks available as report tool (Page 211)".
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Result
The Excel workbooks are made available on the DataMonitor client:

● The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. For more information, refer to "Displaying process data in an Excel 
workbook (Page 205)".

● You can create time-controlled and event-controlled reports using the workbook as 
template. For more information, refer to "Creating reports with an Excel workbook 
(Page 214)".

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

3.6.3.3 Displaying process data in an Excel workbook

Introduction       
You can display process values or archive values and alarms in an available Excel workbook. 
You can edit and save the workbook.

Requirement
● The Excel workbooks were made available as report tool.

● MS Excel for online display in the Excel workbook

● The DataMonitor server is installed.

● The WinCC project is in Runtime.

● The start page of the DataMonitor is open.

● A user is created in WinCC.
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Procedure
1. Click "Reports" on the start page.

2. Click "Report tools".
You see the Excel workbooks that you have published in the Excel Workbook Wizard or 
made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed 
in the "WinCC server" field.
The "WinCC Server" field can include the following information:

– Access via domain: The server name and the domain are listed for access outside the 
network domain.

– The DataMonitor start page is the default web page: The "WinCC Server" field contains 
only the server name.

– The DataMonitor start page is in the virtual folder: The server name and the name of 
the virtual folder are displayed, e.g. "/webnavigator".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values 
of all servers are updated in the online display.

 

  Note

To establish connections to all servers, activate "all servers" with "Connect" before you 
establish the connections.

 

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened.
Type in the user name and associated password. 
In case of several servers, the log-in dialogs of the respective servers open one after the 
other.
If a connection was not established, a corresponding alarm is displayed. Clicking on the 
dialog will display additional information about the error that has occurred.

 

  Note

Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection 
establishment to the server is still open.

 

WinCC/DataMonitor Getting Started
3.6 Use of DataMonitor

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 87



10.The connection status will be displayed in the dialog.
Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the 
respective values or displays.

11.Activate the check box "Read cyclically" to update the tag values in cycles.

12.Close the "Excel Workbook" dialog after finishing your calculations in Excel.

13.Save the results in the workbook with the "Save as" menu command.

14.Close Excel.

Result
The process data are displayed in the Excel workbook and can be processed further.

3.6.4 Outputting data using "Reports"

3.6.4.1 Reports

Introduction           
Use "Reports" to create time-controlled and event-controlled reports independent of the 
SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis 
results and process data. The reports are output as PDF or XLS file and can be attached to 
an e-mail.
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Requirement
● You need a PDF reader for output as PDF file. The PDF reader can be obtained from 

www.adobe.com for example.

● For Output as XLS-file (Excel workbook):

– MS Excel is installed as of Office XP.
To use the automatic creation of Excel reports on the DataMonitor server, MS Excel 
must be installed on the server.

– The Excel workbook is created and published as template on the DataMonitor server.

● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 
and "Excel Workbook".
For "Excel Workbook" you need "Microsoft Excel 2003 SP3" with installed hotfix KB907417 
or "Office Excel 2007". The hotfix KB907417 is available as "Extensibility Update" in the 
Download area.

Using reports
You determine on the DataMonitor server when you want to create reports:

● Manually, for example, by a plant operator.

● Event-controlled, for example, when a tag value changes.

● Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users 
can access the different folders with appropriate authorization from the DataMonitor client. 

 

 Note

The creation time is always displayed on a DataMonitor client in the local time zone of the 
server.

 

3.6.4.2 Making an Excel workbook available as template

Introduction     
You can make Excel workbooks available as templates to create ""Reports"". For this you have 
the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Template" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.
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Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.

5. Click the "Upload" button.

Result
You can create time-controlled and event-controlled reports using the workbook as template. 

See also
Displaying a report with an Excel Workbook (Page 94)

WinCC/DataMonitor Getting Started
3.6 Use of DataMonitor

WinCC/DataMonitor
90 System Manual, 02/2013, A5E32316056-AA



3.6.4.3 Making an Excel workbook available as a report tool

Introduction     
You can make Excel workbooks centrally available as report tools in "Reports". For this you 
have the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Publish" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

Here you find a description of how you make an Excel workbook not yet published available 
on the DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel 
workbook.

4. Click the "Upload" button.

Result
The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. 
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See also
Displaying process data in an Excel workbook (Page 86)

3.6.4.4 Making Settings for Reports

Introduction           
Different settings are required for using the "Reports" function in DataMonitor. 

Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click on the "Settings" tab. The "Settings" page is displayed.

3. Check the entries in the section "General project settings".
You can now select the printer of the Web server. Printing is only possible in files.

4. To enable the output to a PDF file, activate the option "Activate API print".

5. Enter the data for sending mail in the "Mail" area:

– Server: Outgoing mail server (SMTP)

– User name: Name for the sender

– Password

– Sender: E-mail account used to sending the e-mail

6. Click the disk icon in the section "General project settings" to save your settings.
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7. In the "Settings of the circular buffer" area, you can define the number of created reports 
that are stored in the selected destination directory. The field has a pre-assigned value of 
20. When the maximum number of reports has been reached, the first in, first out principle 
applies. 

8. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have been made.

Product support - example
FAQ "51334611" on the Internet under "Product support" gives a detailed example:

● http://support.automation.siemens.com/WW/view/en/51334611

3.6.4.5 Displaying a report with an Excel Workbook

Introduction     
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports from Excel workbooks. 

Requirement
● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● You have already published or made available as templates the Excel workbooks you want 
to use.

● The start page of the DataMonitor is open.

WinCC/DataMonitor Getting Started
3.6 Use of DataMonitor

WinCC/DataMonitor
94 System Manual, 02/2013, A5E32316056-AA



Procedure
1. Click "Reports" on the start page.

2. Click on the "Excel Workbooks" tab. The "Excel Workbooks" page is displayed.

The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled 
Excel workbooks" are deactivated. The icons indicate that no reports are currently 
configured.

3. Select one of the available Excel workbooks under "Available Excel workbooks".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel 
workbooks" area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".
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9. Click "Add" in the "Time-controlled Excel workbooks" area. The report is displayed in the 
"List of time-controlled Excel workbooks".

10.To configure an event-controlled report, enter the following in the "Event-controlled Excel 
workbooks" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Event-controlled Excel workbooks" area. The report is displayed in the 
"List of event-controlled Excel workbooks".

Result
A time-controlled or event-controlled report is configured as "Excel Workbook". 

The configured reports are displayed in the lists of the "Excel Workbooks" . You can edit or 
delete the reports in the lists. 

Once the report has been created, it is available in runtime on the "Published Reports" tab in 
the selected directory. 

 

 Note
Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater 
than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often 
occurs, for example, with frequent signal changes of a tag that trigger an event-controlled 
report.

 

3.6.4.6 Creating a report with a print job

Introduction     
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports using print jobs in PDF format. 

Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.
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● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Print jobs" tab. The "Print jobs configuration" page is displayed.

The icons in front of "List of time-controlled print jobs" and "List of event-controlled print 
jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.
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8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" 
area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
time-controlled print jobs".

10.To configure an event-controlled report, enter the following in the "Event-controlled print 
jobs" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
event-controlled print jobs".

Result
A time-controlled or event-controlled report is configured as print job in PDF format. 

The configured reports are displayed in the lists of the print jobs. You can edit or delete the 
reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC 
Runtime language does not have an effect on the representation of dynamic elements, such 
as tables.

Once the report has been created, the PDF files are available in runtime on the "Published 
Reports" tab in the selected directory.

 

 Note
Opening Asian PDF files with Acrobat Reader

To open the Asian PDF files created with "Reports", you need the country-specific version or 
the respective font package of the Adobe Acrobat Reader.

The four Asian languages are fixed to one font each. This means the font settings in the report 
layout will not have an effect on the Asian languages.
Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is 
greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled print jobs over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often 
occurs, for example, with frequent signal changes of a tag that trigger an event-controlled 
print job.
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3.6.5 Creating Webcenter pages in "Webcenter"

3.6.5.1 Web center

Overview         
The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. 
Users can use the Webcenter pages and web parts to compile and save their views of WinCC 
data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout 
templates. Users can either use the supplied layout templates or the ones they create 
themselves.

The web parts are the individual blocks that prepare and display data. You can combine up to 
15 web parts in one screen view. For more information, refer to "Overview of web parts 
(Page 99)".

Within the WebCenter pages, the configuration of the respective web part is stored and can 
be called up again at any time. The multiple use of the same web part with different 
configuration is also possible. The WebCenter pages that have been created in this way can 
be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder:

"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"

Basic procedure
1. Creating directories for Webcenter pages

2. Assigning Access Rights

3. Establishing connection to the WinCC data

4. Publishing pictures for the Webcenter

5. Creating layout template for Webcenter pages

6. Creating Webcenter page

7. Inserting web parts to the Webcenter page

8. Configuring web parts within Webcenter pages

3.6.5.2 Overview of Web Parts

Overview     
You compile Webcenter pages from the web parts in the "Webcenter". 

The following web parts are available:

WinCC/DataMonitor Getting Started
3.6 Use of DataMonitor

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 99



● Process value table
The available process values are displayed for the defined time period.

● Process Values in the Table (Timestep)
The complete archive name and the tag name are displayed as tooltip in the column header.
The process values are combined beginning with the starting time in the defined time 
interval. 
Depending on the set aggregate type, the interval for the interval event is displayed.
For example, a process value was archived every 30 seconds. You have selected an 
interval of 60 seconds and the aggregate type "Average value". It determines the average 
value of two archive values each, which is then displayed in the table with the first time 
stamp of the averaging interval. 
If you select an aggregate type without interpolation, and if no value is present in the interval, 
no interval result will be displayed. If you select an aggregate type with linear interpolation, 
an interval result is displayed for each interval. 

● Statistics functions for process values
All available process values are used for the defined time period, for example, to calculate 
and display the average value.

● Trend Process Values
The process values are displayed with trends.

● Trend (Timestep)
Clear presentation of precompressed values in trends with aggregate functions, such as 
sum or average.

● Bar Chart (Aggregates)

● Pie Chart (Aggregates)

● Alarm table
Presentation of accrued alarms.

● Alarm hit list
Presentation of statistical information on alarms.

● Link to WebCenter pages

● Links (external)
Links to internal Webcenter pages and external Internet pages, such as stock market news.

● Displaying information
 Such as news, for example.

● Static process pictures
WinCC pictures are integrated into the Webcenter without installation download. A JPG 
screenshot of the process picture is created on the DataMonitor server at regular intervals.

● Display Graphic
JPG screenshots, such as company logo.

● The Last Reports
Display the reports created last, for example, the last ten print jobs in PDF format created 
with "Reports".
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See also
Displaying process values in a table (Page 180)

Displaying process values in a diagram (Page 181)

Displaying the hit list of messages (Page 187)

Displaying messages in the alarm table (Page 183)

Displaying statistics function for process values (Page 189)

3.6.5.3 Creating layout template for Webcenter pages

Introduction         
You need a layout template to create a Webcenter page. Predefined layouts were installed 
during the installation. Additionally, you can create your own Layout Templates.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating layout" tab.

3. Define the number of columns and the number of lines.

4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".
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5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1. The modified view will be 
displayed.
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6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol 
in a table field to place the web parts vertically or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a Webcenter page. 

3.6.5.4 Creating Webcenter page

Introduction   
You create Webcenter pages in which you add web parts. The Webcenter pages are stored 
in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user 
group has the "Edit" or "Create" access rights. 
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Requirement
● The directory ""myPart"" is set up.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating page" tab.

3. Click on the desired layout template. The file name is displayed in the "Layout file" field.

4. Enter a name in the "Webcenter page" field, for example, ""My_Webcenter"".
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5. Select the directory in which the Webcenter page is stored. The selected directory is 
displayed in the field "Save WebCenter page as".

6. Click "Save".

Result
The Webcenter page "My_Webcenter" is created and saved.
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3.6.5.5 Inserting web parts to the Webcenter page

Introduction       
You compile the contents of the Webcenter pages from the web parts. 

Requirement
● The directory ""myPart"" is set up.

● The Webcenter page "My_Webcenter" is stored in the directory.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Pages" on the start page.

2. Click on the "myPart" tab.

3. Click on the entry "My_Webcenter".
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4. To add web parts, click  at the top right corner of the page. The available web parts are 
listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms".
If you insert several web parts into a table field, the web parts are arranged horizontally or 
vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".
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Result
Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current 
compilation of the Webcenter page is displayed.
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WinCC/DataMonitor Documentation 4
4.1 Basic principles

4.1.1 DataMonitor

Overview   
You can display and evaluate current process states and historical data with WinCC/
DataMonitor via the Intranet/Internet. 

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor 
server makes functions available to the DataMonitor client for analysis and display of data. 
Access rights control access to the functions.

● "WinCCViewerRT":
Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only 
Client".

● "Excel Workbook":
Display of process values and archive values in an Excel table for evaluation and display 
via the web or as a print template for reports

● "Reports":
Creating reports from WinCC print jobs or from published Excel workbooks. This also allows 
for statistics and analyses of certain process data or historical data. The reports are created 
in PDF format and forwarded as e-mail if necessary.

● "Webcenter":
Central information portal for access to WinCC data via user-specific views. Clearly 
structured Webcenter pages with individual user rights for reading, writing and creating 
Webcenter pages.

● "Trends & Alarms":
For display and analysis of archived process values and alarms. The data is displayed in 
tables and diagrams on predefined Webcenter pages.

Quantity Structure
WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server. When 
using the terminal services, up to 25 DataMonitor clients are released per terminal services 
server. 
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4.1.2 WinCCViewerRT

Overview     
The Web Viewer "WinCCViewerRT" is solely a display program for WinCC projects that is 
installed with the DataMonitor client. The DataMonitor Client is therefore a "View Only Client". 

You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the DataMonitor 
Client. 

The Web Viewer accesses the DataMonitor server using its own communication. This way you 
prevent access by users to the Internet and protect the system from viruses and trojans. 

The viewer only displays the pictures that you configured for web access and published on the 
DataMonitor server.

The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only". 
The "View Only Cursor" indicates that process-related operations are not possible. Certain 
operations, such as opening the properties dialog of an OnlineTrendControl, are still possible. 

If the WinCC user does not have authorization no. 1002, the DataMonitor client runs in demo 
mode after logon.

4.1.3 Web center

Overview         
The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. 
Users can use the Webcenter pages and web parts to compile and save their views of WinCC 
data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout 
templates. Users can either use the supplied layout templates or the ones they create 
themselves.

The web parts are the individual blocks that prepare and display data. You can combine up to 
15 web parts in one screen view. For more information, refer to "Overview of web parts 
(Page 111)".

Within the WebCenter pages, the configuration of the respective web part is stored and can 
be called up again at any time. The multiple use of the same web part with different 
configuration is also possible. The WebCenter pages that have been created in this way can 
be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder:

"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"
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Basic procedure
1. Creating directories for Webcenter pages

2. Assigning Access Rights

3. Establishing connection to the WinCC data

4. Publishing pictures for the Webcenter

5. Creating layout template for Webcenter pages

6. Creating Webcenter page

7. Inserting web parts to the Webcenter page

8. Configuring web parts within Webcenter pages

4.1.4 Overview of Web Parts

Overview     
You compile Webcenter pages from the web parts in the "Webcenter". 

The following web parts are available:

● Process value table
The available process values are displayed for the defined time period.

● Process Values in the Table (Timestep)
The complete archive name and the tag name are displayed as tooltip in the column header.
The process values are combined beginning with the starting time in the defined time 
interval. 
Depending on the set aggregate type, the interval for the interval event is displayed.
For example, a process value was archived every 30 seconds. You have selected an 
interval of 60 seconds and the aggregate type "Average value". It determines the average 
value of two archive values each, which is then displayed in the table with the first time 
stamp of the averaging interval. 
If you select an aggregate type without interpolation, and if no value is present in the interval, 
no interval result will be displayed. If you select an aggregate type with linear interpolation, 
an interval result is displayed for each interval. 

● Statistics functions for process values
All available process values are used for the defined time period, for example, to calculate 
and display the average value.

● Trend Process Values
The process values are displayed with trends.

● Trend (Timestep)
Clear presentation of precompressed values in trends with aggregate functions, such as 
sum or average.

● Bar Chart (Aggregates)

● Pie Chart (Aggregates)
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● Alarm table
Presentation of accrued alarms.

● Alarm hit list
Presentation of statistical information on alarms.

● Link to WebCenter pages

● Links (external)
Links to internal Webcenter pages and external Internet pages, such as stock market news.

● Displaying information
 Such as news, for example.

● Static process pictures
WinCC pictures are integrated into the Webcenter without installation download. A JPG 
screenshot of the process picture is created on the DataMonitor server at regular intervals.

● Display Graphic
JPG screenshots, such as company logo.

● The Last Reports
Display the reports created last, for example, the last ten print jobs in PDF format created 
with "Reports".

See also
Displaying process values in a table (Page 180)

Displaying process values in a diagram (Page 181)

Displaying the hit list of messages (Page 187)

Displaying messages in the alarm table (Page 183)

Displaying statistics function for process values (Page 189)

4.1.5 Trends and Alarms

Overview     
"Trends & Alarms" is used for display and analysis of archived process values and alarms.

Predefined web pages have the following content:

● Displaying process values in a table (Page 180)

● Displaying a maximum of three process values in a diagram. Displaying process values in 
a diagram (Page 181)

● Displaying statistics function for process values (Page 189)

● Displaying alarm hit list (Page 187)

● Displaying alarms in the alarm table (Page 183)

The functions of "Trends & Alarms" are configured with web parts. Use the same web parts 
for this purpose that you used for the Webcenter pages.
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Within Trends & Alarms each user can only make one configuration for each web part. The 
configuration is saved for the user. Other users cannot access the configuration of this web 
part directly.

4.1.6 Excel workbook

Overview         
With the Excel add-In "Excel Workbook" you can display the following data of the WinCC 
project in an Excel workbook on the DataMonitor client:

● Alarms

● Values of process tags and archive tags

● Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e. g. as average value calculation 
or diagram representation. The created Excel workbooks are made available as templates for 
"Reports" and as report tools.

Requirement
● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 

and "Excel Workbook" on the DataMonitor client.
For "Excel Workbook" you need "Microsoft Excel 2003 SP3" with installed hotfix KB907417 
or "Office Excel 2007". The hotfix KB907417 is available as "Extensibility Update" in the 
Download area.

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
"Excel Workbook". This requires that you either take the data from an XML file or from a local 
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WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard" . A 
separation between process and evaluation is possible with the XML file. 

● A WinCC project is open on the DataMonitor server.
The XML file is generated with the "Export Configuration Data" function. 
Then transfer the XML file to a computer with Microsoft Excel. 
Configure the process data display in the workbook. 
Afterwards, transfer the workbook to a DataMonitor client that displays the process data 
online.

● To accept the data of the WinCC project online, configure directly on the WinCC server or 
on a WinCC client with an online connection to the respective WinCC server.

● Import the data into an Excel workbook using the "Excel Workbook Wizard".
Then configure the display of alarms and tag values.

 

  Note

If you rename a table in an Excel workbook, the configuration data of the table will be lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During 
online display with "Excel Workbook" you may experience considerable delays in updating 
when there is a large number of tags.

 

4.1.7 Reports

Introduction           
Use "Reports" to create time-controlled and event-controlled reports independent of the 
SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis 
results and process data. The reports are output as PDF or XLS file and can be attached to 
an e-mail.

Requirement
● You need a PDF reader for output as PDF file. The PDF reader can be obtained from 

www.adobe.com for example.

● For Output as XLS-file (Excel workbook):

– MS Excel is installed as of Office XP.
To use the automatic creation of Excel reports on the DataMonitor server, MS Excel 
must be installed on the server.

– The Excel workbook is created and published as template on the DataMonitor server.

● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 
and "Excel Workbook".
For "Excel Workbook" you need "Microsoft Excel 2003 SP3" with installed hotfix KB907417 
or "Office Excel 2007". The hotfix KB907417 is available as "Extensibility Update" in the 
Download area.
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Using reports
You determine on the DataMonitor server when you want to create reports:

● Manually, for example, by a plant operator.

● Event-controlled, for example, when a tag value changes.

● Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users 
can access the different folders with appropriate authorization from the DataMonitor client. 

 

 Note

The creation time is always displayed on a DataMonitor client in the local time zone of the 
server.

 

See also
Configuring the display of tag values (Page 75)

Making an Excel workbook available as template (Page 210)

Configuring the Excel workbook (Page 71)
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4.2 Configuring the DataMonitor system

4.2.1 Overview of the configuration steps

Introduction   
For use of WinCC/DataMonitor the data and process pictures are made available on the 
DataMonitor server. The DataMonitor client accesses the available data to display data and 
process pictures.

Requirement
● Server and client are interconnected.

● On the server

– Internet Information Service is installed.

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– WinCC is installed.

● On the client

– Internet Explorer is installed.

Configuration steps
You have to complete the following configuration steps to set up the DataMonitor system.

1. Configuration of the WinCC project.

– Publish WinCC pictures.

– Define users and access rights in "WinCC User Administrator", if you use 
WinCCViewerRT and/or "Excel Workbook" .

– Configure the settings for Runtime.

2. Configure the DataMonitor server.

– Set up the web page and firewall.

– Define users and access rights in Windows, if you use "Trend & Alarms", "Reports" and 
"Webcenter".

3. Start WinCC Runtime on the server.
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4. Use the DataMonitor functions on the DataMonitor client.

– Check the security settings of the Internet Explorer.

– Start the Internet Explorer and enter the address of the DataMonitor server.

– Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project on the DataMonitor client.

– Configuring WinCCViewerRT

– Displaying pictures

 

See also
Defining users in Windows (Page 139)

Configuring the DataMonitor web page (Page 131)

Configuring security settings in Internet Explorer (Page 141)

Configuring runtime settings (Page 129)

Creating static process pictures for the Webcenter (Page 165)

4.2.2 Configure the WinCC project

4.2.2.1 Publishing WinCC process pictures

Publishing WinCC Process Pictures

Introduction                 
If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor 
Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which 
automatically makes the necessary adaptations to the project data. 
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Overview
The Web View Publisher enables the following types of publishing: 

● Publishing on the local computer.
The current WinCC project folder is the source folder.
The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

● Publishing on a dedicated web server with a server prefix.
The source folder is the WinCC project folder on another WinCC computer that is defined 
by the server prefix.
The target folder is located in subfolder ".../WebNavigator/Pictures" of the WinCC project 
on the WinCC Client. The pictures of your own project are saved with the name 
"<picturename>.PD_", while the pictures of other projects are saved with the name 
"<serverprefix>_ _<picturename>.PD_".

● Remote publishing.
The source and target folders can be located on the same or different web servers.
You can start the Web View Publisher on the web server with the source and target folder 
or on a third web server.

● Remote publishing on a dedicated web server or WinCC Client from a different remote 
station.
The project folder of the WinCC project must be released in Windows on the dedicated web 
server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC 
project of the web server/WinCC Client on the remote computer. On the remote station, 
you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

● Compression of the data for optimizing performance on the Internet.

● Removal of project-specific data that is not required for the operation.

● Conversion of picture windows into an ActiveX component.

● Conversion of scripts so that they can be run on the Client.

Publication of pictures with faulty scripts
If warnings or errors are generated during publishing, the process pictures affected are marked 
in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are 
nonetheless published. However, errors can still occur in Runtime and are reported by the 
WebNavigator Client. 

The "PdlPad" tool can be started directly in the Web View Publisher in order to check and, if 
necessary, correct the scripts used in the published pictures.

Publishing Without Project Functions
Publishing without project functions can be an additional source of error. When publishing with 
the Web View Publisher, the selected project functions are always published. When published 
without project functions, the pictures no longer contain any project functions. The project 
functions of the last publishing process are always available in the published pictures and, 
therefore, on the client. 
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The selection of project functions in the Publisher is independent of the pictures published in 
the same process. If , for example, you modify selected project functions but not their 
interfaces, you need to publish all necessary project functions. In this case, you do not have 
to publish the picture.

Changing the process picture in Graphics Designer
Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server 
must be published once again. This is required for the process picture to be displayed on the 
WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote 
station in order to transfer the changes to the WebNavigator Client. On completion, open and 
save the modified picture in Graphics Designer. Publish the picture in the next step using Web 
View Publisher on the dedicated web server. 

If you have modified a large number of pictures, you can simplify this process. For this purpose, 
call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, 
you once again have to publish the pictures.

Requirements for publishing pictures

General requirements             
● The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". 

The string before the double underscore will be interpreted as server prefix.

● Moreover, the name cannot begin with a single underscore if you are using Basic Process 
Control. When using Picture Tree Manager, the name string of higher-level pictures will 
have a "@PTN_" prefix. With the leading underscore, the picture name will then have a 
double underscore.

● If two header files of the same name exist in the project path and in the installation path of 
WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server
● The Web Navigator Server is installed on the WinCC Client.

● The C and VB scripts of all WinCC servers to which the WinCC Client has access have 
been copied to the WinCC Client.

● The WinCC server packages that the WinCC Client can access are loaded on the WinCC 
Client.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.
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Requirements for remote publishing
● Access to the target and source folders is enabled for Web View Publisher.

WinCC configures these Windows enables by default. Verify that these enables are not 
restricted, for example, valid for specific users only.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".

WinCC/DataMonitor Documentation
4.2 Configuring the DataMonitor system

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 121



3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.

WinCC/DataMonitor Documentation
4.2 Configuring the DataMonitor system

WinCC/DataMonitor
122 System Manual, 02/2013, A5E32316056-AA



6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list.

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".

4.2.2.2 Administering users for DataMonitor

Introduction     
For the use of certain functions on the DataMonitor client, users need authentication as 
DataMonitor user as well as authentication as WinCC user. Use one WinCC user for 
"WinCCViewerRT" and "Excel Workbook".

If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to 
log on twice. You have two alternatives to only log on once:
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● The DataMonitor user and the WinCC user have identical names and passwords.
The user must be configured in Windows and in WinCC and added to the "SIMATIC HMI" 
and "SIMATIC HMI VIEWER" user groups.

● SIMATIC logon allows the central administration of users.
In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must 
also be added to the user group "SIMATIC HMI VIEWER".

Procedure
1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select 

the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select "Create User" in the "User" menu.
The "Add New User" dialog box opens.
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4. Enter a name and a password with at least six characters for "Login".
Click "OK".

5. Select the newly created user.
Select the "Web Navigator" check box in the table window.
The "Web Options" area is displayed.

6. Click the "..." button to create a start picture.
Select a start picture, such as "start.Pd_".

7. Check the selected language and change this setting if desired via the "..." button. Only 
languages that have been installed in WinCC are available for selection.

8. The user needs at least the authorization no.1002 "Web Access - monitoring only".
Double-click the "Release" column in the row of the authorization.
A red dot indicates the activated authorization.

9. Close the User Administrator.

4.2.2.3 Configuring runtime settings

Introduction       
Define the settings for behavior in runtime when you use the DataMonitor.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog.
Select the required settings. Close the dialog with "OK".

Using "WinCC Classic" design
Activate the option to improve the performance of the DataMonitor client. The original style of 
WinCC V6 is now used.

"Monitoring only" cursor
A default cursor shows that the user of the DataMonitor client is not permitted to operate 
Runtime. The user has been assigned system authorization no. 1002 - "Web access - 
monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." 
button to navigate to the file of the selected cursor.

Server load
You do not need the settings in the area "Server load" for DataMonitor.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/
logoff of a DataMonitor client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.
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Disable local groups of SIMATIC Logon
The DataMonitor server can only be accessed by groups in the same domain.

4.2.3 Configuring the DataMonitor system

4.2.3.1 Configuring the DataMonitor web page

Introduction     
You create the DataMonitor web page with the WinCC Web Configurator.

Requirement
● The DataMonitor server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Click the "Web 

Configurator" command in the shortcut menu.
You can also select the "Start > Programs > Siemens Automation > Option and Tools > 
HMI Tools > WinCC Web Configurator" command in the Windows Start menu.

2. The Web Configurator detects whether a configuration already exists.

– No configuration found: Activate "Create a new standard website (Standalone)". Click 
"Next".

– Configuration found: Click "Next" and check the configuration.

WinCC/DataMonitor Documentation
4.2 Configuring the DataMonitor system

WinCC/DataMonitor
132 System Manual, 02/2013, A5E32316056-AA



3. Select "Name of the web page" and enter the name.

4. Enter the number of the port used for access in the "Port" field.

5. At "IP address", specify whether the computer is to be available on the Intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list.
Select "All not assigned" to enable Intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection 
automatically in case of a connection error. A time setting of "0 s" disables the "Automatic 
reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall.
Click "Next" if you have installed a firewall. See the following pages to find out how to set 
up a firewall.

Result
You have created the Web folder and activated the web page. When you have activated the 
firewall, use the Web Configurator to configure its settings. 

See also
Configure the firewall (Page 134)
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4.2.3.2 Configure the firewall

Configuring the Firewall in Windows XP/Windows 2003

Introduction       
This section describes how to activate the "HTTP" or "HTTPS" services and the procedure for 
other port settings in Windows XP or Windows 2003.

Requirement
● A default web page was created using the Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".
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Procedure for the default port
1. Click the "Windows Firewall" button in the Web Configurator.

The "Windows Firewall" dialog opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button.
The "Advanced Settings" dialog opens.
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3. Select the "Secure Web server (HTTPS)" or "Web server (HTTP)" check box.
Click the "Edit" button to display the current service settings for the web server.

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator. The server configuration is completed.
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Procedure for other port settings
Customize the Windows Firewall settings as follows if you are not using the default port.

1. Click the "Windows Firewall" button in the Web Configurator. The "Windows Firewall" dialog 
opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button. The "Advanced 
Settings" dialog opens.

3. Click "Add" in the " Advanced Settings" dialog.
The "Service Settings" dialog opens.
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4. Specify the web server settings:

– Web server name in the "Service description" field

– Name or IP address

– External and internal port number for this service

– "TCP" service

Confirm with "OK".

5. Activate the web server you created in the "Advanced Settings" dialog.

6. Close all Windows dialogs with "OK".

7. Click "Finish" in the Web Configurator. The server configuration is completed.

Configuring the Firewall in Windows 7/Windows 2008

Introduction       
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 
7 or Windows 2008.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows 2008: Click "Allow a program to communicate through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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4.2.3.3 Defining users in Windows

User groups in Windows

Overview           
The following user groups are created automatically in Windows when the DataMonitor server 
is installed.

SIMATIC Report Administrators
Membership of the user group "SIMATIC Report Administrators" is required for extended rights, 
especially for configuration purposes. At least one user must be created and assigned to the 
"SIMATIC Report Administrators" user group.

● You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":

– Configuring connections

– Creating templates for Webcenter pages

– Creating and configuring public and private Webcenter pages

● You can also do the following as "SIMATIC Report Administrators" in "Reports":

– Configuring reports based on WinCC print jobs or Excel workbooks.

SIMATIC Report Users
Membership of the user group "SIMATIC Report Users" or of your own user group is required 
for the "Webcenter", "Trends & Alarms" and "Reports".

● You can also do the following as "SIMATIC Report Users" in the "Webcenter":

– Setting up and configuring Webcenter pages. The Webcenter pages are stored in 
different directories.

– Opening public pages

● You can also do the following as "SIMATIC Report Users" in "Reports":

– Opening reports based on WinCC print jobs or Excel workbooks.

 

Defining Users and Access Rights in Windows

Introduction       
When using DataMonitor, users need different authentications. All users must be members of 
the "SIMATIC HMI" user group. For access to the WinCC database via DataMonitor, you need 
a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group.

This means you must create users with the matching user rights.
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Requirement
● WinCC is installed.

● The DataMonitor server is installed.

Procedure using Windows XP as an example 
1. From the Windows Start menu choose "Settings > Control Panel".

2. Double-click the "Administration" entry.

3. Double-click the entry "Computer Management" in the "Administration" dialog.
The "Computer Management" dialog is opened.

4. Navigate to the directory "System > Local Users and Groups / Groups". In the shortcut 
menu select the entry "New user".

5. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" field.
Enter a description such as "User for DataMonitor" in the "Complete name" field.
Type the desired password into the "Password" field and then repeat it in the "Repeat 
password" field.
Create the user with "Create".
Close the "New user" dialog.

6. In the right part of the table window, click on the newly created user. In the context menu 
select the entry "Properties".
Click on the "Membership" tab.
Click "Add".

7. In the "Select groups" dialog, click the "Extended > Find now" button.

8. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI"  and "SIMATIC HMI 
VIEWER" from the list at the bottom of the dialog.
Click "OK" twice to close the dialog.

9. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI"  
and "SIMATIC HMI VIEWER" have been added to the list of memberships.
Click "OK".

10.Close the dialog "Computer Management" using the entry "File > Exit".

11.Close the dialog "Management" using the entry "File > Exit".

Result
The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", 
"SIMATIC HMI"  and "SIMATIC HMI VIEWER" has been set up. The user can now create 
directories in the Webcenter and make connections to WinCC databases.

 

 Note

If a user wants to access remote computers via the DataMonitor server, the Windows user 
must be set up on the DataMonitor server as well as the remote servers with the same 
password.
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4.2.4 Working with the DataMonitor client

4.2.4.1 Configuring security settings in Internet Explorer

Introduction     
For full functionality on the DataMonitor client, adapt the security settings in the Internet 
Explorer. 

Requirement
● Internet Explorer is installed.

Procedure
1. Click "Tools > "Internet Options" in the Internet Explorer.

This will open the "Internet Options" dialog.

2. Select the "Security" tab.

3. Select the "Trusted Sites" icon and click the "Sites" button.
The "Trusted Sites" dialog opens.

4. Enter the address of the DataMonitor server in the "Add this website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. Deactivate the "Require server verification (https:) for all sites in this zone" check box.
Click "Add".
Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level".
Click "Adapt Level" in the next dialog.
The "Security settings" dialog box is opened. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".

Result
The necessary settings in the Internet Explorer of the DataMonitor client are configured.

User authentication: Activated setting "Automatic logon with current user name and password" in 
Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet 
Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User 
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Authentication" > Logon", this can lead to unexpected behavior under the following 
requirements.

Requirement
● The "Automatic logon with current user name and password" The setting is activated in 

Internet Explorer.

● The user logs onto the DataMonitor client as a WinCC user who is not configured in the 
user groups on the DataMonitor server.

● The user is logged onto the computer with a Windows logon that is set up as a user name 
on the DataMonitor server.

Behavior
1. The DataMonitor server does not recognize the WinCC user name the user has used to 

log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.

2. Internet Explorer automatically starts a new logon using the current Windows logon as user 
name.

3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and 
accepts the logon for this user.

4. The user is logged on but not with the DataMonitor user name the user has entered. The 
current DataMonitor user is not displayed.

Recommendation
Disable the "Automatic logon with current user name and password" setting. 

Use the setting only when there is a clear distinction between Windows logon and DataMonitor 
user name.

4.2.4.2 DataMonitor start page on the DataMonitor client

Overview         
You start the DataMonitor client on a standalone computer or on a DataMonitor server. The 
start page of the DataMonitor summarizes the functions of the DataMonitor: 

● "Reports":
Creation and output of analysis results and process data in print jobs and published Excel 
workbooks.

● "Webcenter":
Creation of Webcenter pages for the display of archived data.

● "Trends & Alarms":
Display of alarms and process values from archives in tables and diagrams.

● "Administration"
Configuration of connections and management of users, archives and pictures.
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Requirement
● The user is created in WinCC.

● The user must be a member of the Windows user group "SIMATIC Report Administrators" 
or "SIMATIC Report Users" .

● The WinCC project on the DataMonitor server is in runtime.

Procedure
1. Start the Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL.
Confirm the entry with "Enter".
The log-in dialog is opened.

3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result
The start page with the DataMonitor functions will be displayed. The use of the functions 
depends on the access right of the user. 
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General Operations of the DataMonitor Client
● Select the desired interface language from the selection field in the header.

● Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary.
Click . 
To show the header line again, click on the symbol .

● In order to log off from the DataMonitor server, click on the "Log off" link.
Exit Internet Explorer to free-up the used license immediately.

See also
Working with trends and alarms (Page 180)

Working with reports (Page 210)

Working with the Webcenter (Page 150)
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4.3 Working with WinCCViewerRT

4.3.1 Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

Requirement
● On the server

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring 
only".

● On the client

– The DataMonitor client is installed.

WinCC/DataMonitor Documentation
4.3 Working with WinCCViewerRT

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 145



Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: "http://<Servername>" or "http://<IP-Adresse>"

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions
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5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the DataMonitor server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is available in the folder "Documents and Settings\User\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

 

 Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.
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4.3.2 Displaying pictures

Requirement       
● A WinCC/DataMonitor license is installed on the DataMonitor server.

● The WinCC project on the DataMonitor server is in runtime.

● The WinCC pictures are configured and published for web access.

● The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".

● WinCCViewerRT is configured on the DataMonitor client.

Procedure
1. Start WinCCViewerRT in the Windows Start menu with "Start > Programs > Siemens 

Automation > Options and Tools > HMI Tools".

2. Log on to the DataMonitor server:

– A login dialog is not displayed if the user name and password are set in the 
WinCCViewerRT configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC 
user. Click "OK".

3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Click "OK". 
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The pictures of 
WinCC project are displayed. 

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 129)".

The <F5> key triggers a reselection of WinCCViewerRT.
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4.4 Working with the Webcenter

4.4.1 Administration

4.4.1.1 User Groups and Directories

User Groups and Directories

Overview           
WebCenter pages and reports are stored in directories on the DataMonitor server. 

Its standard complement of directories is as follows:

● "Public"

● "Private" Every user has a "Private" directory. Only the respective user has access rights 
to this directory.

A user of the user group "SIMATIC Report Administrators" can create other directories and 
assign the other user groups different access rights to these directories. 

More information on setting up directories can be found in chapter "Setting up directories 
(Page 152)".

Windows User Groups
The user groups "SIMATIC Report Administrators" and "SIMATIC Report Users" are created 
when the DataMonitor server is installed. You can create more user groups. More information 
on setting up user groups and users can be found in chapter "Defining users and access rights 
in Windows (Page 139)".

To access the DataMonitor, assign all members of a user group the same access rights to the 
directories of the DataMonitor server.

The following access authorization is possible:

● Read

● Change

● Create

A user, as a member of a user group, only has access to a directory if the respective user 
group has access rights to that directory. This permits user group-specific access. More 
information on assigning access authorization can be found in chapter "Assigning access 
rights (Page 152)".

The following picture shows the basic user administration for the WebCenter.
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Creating Directories

Introduction   
You store Webcenter pages in directories. The default directories are "Public" and "Private". 

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click the "Directory administration" tab.

3. Enter a name, such as "mypart", in the "New directory" field.

4. Click the "Create" button.

Result
The directory "mypart" is created. The directories are created in a layer.

Assigning Access Rights

Introduction     
Directories are created within the Webcenter in which you store, for example, Webcenter 
pages. You can assign different access rights for the individual directories to Windows user 
groups.

The following access authorization is possible:
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● Read

● Change

● Create
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Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click on the "User administration" tab.

3. Select the desired directory from the "Current directory".
All existing Windows user groups are listed.
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4. Activate the access rights in the line of the required Windows user group.

5. Click "Save".

Result
The access rights for the required directory are configured.

See also
User Groups and Directories (Page 150)

Example: User Groups and Directories

Overview     
The user groups "Service" and "Planning" have been created in the following example. The 
directories "ServiceGroup", "Water" and "ProcessPlans" are created in the Webcenter.

The following table shows which access rights the members of the user groups "Service" and 
"Planning" have for the following directories:

Directory User group "Service" User group"Planning"
Public ● Read ● Read
Private ● Read

● Change
● Create

● Read
● Change
● Create

ServiceGroup ● Read
● Change
● Create

● Read

Water ● Read
● Change

No access authorization

ProcessPlans No access authorization ● Read
● Change

When a member of the user group "Service" logs in and clicks "Pages" in the Webcenter, the 
member will see the directories as tabs to which the user group has at least read access. The 
"Webcenter > Pages" looks as follows for the member "Service_014" of the user group 
"Service":
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The "Webcenter > Pages" looks as follows for the member "Plan_012" of the user group 
"Planning":

4.4.1.2 Create connection and set up language

Introduction     
For access of the DataMonitor client to runtime data and archived data configure connections 
to the WinCC databases in the "Webcenter". Set up a connection for each data source, e.g. 
to WinCC server or CAS. You need the configured connections for Webcenter pages and 
"Trends & Alarms". 

Requirement
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● For access to the WinCC database via DataMonitor, a Windows user with password is 
created who is a member of the "SIMATIC HMI VIEWER" user group.
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Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click the "Connection Administration" tab.

3. Select the option "New Connection". After the new installation, no selection is possible in 
the "Connection" field, as no connections have been configured yet.

4. Select the language that corresponds with the linguistic region of the server or archive to 
be linked in "Linguistic Region". The setting ensures that special national characters are 
displayed correctly. 

5. Enter a name in the "Connection Name" field, such as "WinCC1_Runtime". The name 
should include a reference to the selected connection type. Do not use any blank spaces 
or special characters.

6. Enter the computer name on which the archive backup data are stored.
As an alternative, select the name of the computer using the "Find" button.

7. Enter the Windows user with password for the connection with the WinCC database.
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8. Select the connection type to the WinCC data:

– "Swapped-out WinCC archive". Additional steps are necessary to access data on 
swapped archives. More information is available under "Connecting or separating 
swapped archives (Page 158)".

– "WinCC Runtime". Only the open single segment of the Runtime database is used.

– "CAS". The WinCC data of the central archive server are used.

– "WinCC Runtime + all segments". The open single segment and all other connected 
segments of the Runtime database are used.

9. Select the database for the connection type:

– "Swapped-out WinCC archive": Click "Display database" or select the archive from the 
list.

– "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC 
project. As an alternative, select the name of the database using the "Find" button.

– "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as 
database.

10.Activate "Automatic adaptation of RT database" so that the database name is adjusted in 
the connection administration during a segment change.

11.Click the "Create" button.

Result
The connection to the data source is created and can be selected in the "Connection" field of 
the connection administration. 

See also
Configuring a symbolic directory (Page 158)

Connect archives using the WinCC Archive Connector (Page 162)

4.4.1.3 Connecting or disconnecting swapped archives

Configuring a symbolic directory

Introduction                 
To access data on swapped-out WinCC archives, these archives must be connected to an 
SQL server once again. 

You can connect all or individual archive backup files of a directory with the SQL server.

WinCC/DataMonitor Documentation
4.4 Working with the Webcenter

WinCC/DataMonitor
158 System Manual, 02/2013, A5E32316056-AA



If you want to remove a directory containing archives from the list of symbolic names, 
disconnect all archives contained therein. You see the status of the archives on the tab 
"Connecting/disconnecting archives".

 

 Note
Connected archives on changeable media

Before changing the media in the drive you need to disconnect the archives on this medium. 
After changing the medium, check whether the archives are connected on the new medium.

 

Requirement
● Archive backup files are write-protected. Create a backup copy of the file before connecting 

and remove the write-protection of the copied archive backup file.

● The archive backup files are stored on a local drive.

● The directories in which the archive backup files are stored have been released.

– The directory must be set for sharing in the Windows Explorer before you start the 
DataMonitor server.

– Restart the DataMonitor server if you are releasing the directories at a later time.

● The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".

● Windows Server 2003/2008: "Network service" is added in the "Print operators" group.

● Windows XP / Windows 7: "Network service" is added in the "Main user" group.

Procedure 
1. Click "Webcenter > Administration" on the start page.

2. Click on the "Archive administration" tab.

3. In the "Symbolic Name" field, enter a unique symbolic name for each directory. The name 
should only contain characters permitted in the SQL syntax. You use the symbolic name 
for access via the DataMonitor client.
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4. Select the folder which contains the archive backup files. You can only select released 
directories.

5. To automatically connect all existing archive backup files of the directory, activate 
"Automatically connect all archives in this directory".

6. To connect individual archive backup files of the directory, deactivate "Automatically 
connect all archives in this directory".

7. Click "Add".

Result
The symbolic directory "Test" is created. 

If you have deactivated "Automatically connect all archives in this directory", specify the archive 
backup files on the "Connecting/disconnecting archives" tab. To disconnect archives, 
deactivate the respective archives on the "Connecting/disconnecting archives" tab. 

Connecting or disconnecting archives

Introduction
All archives of a selected archiving directory are displayed on the "Connecting/disconnecting 
archives" tab. You can connect or disconnect the existing archives.

Requirement
● Archive backup files are write-protected. Create a backup copy of the file before connecting 

and remove the write-protection of the copied archive backup file.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".

● A symbolic directory is created, such as "Test".
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Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click on the "Connecting/disconnecting archives" tab.

3. Select a directory from "Symbolic directories", such as "Test". The available archives are 
displayed in a list. The "Info" column indicates the status:

– Green: Connected

– Red: Disconnected

4. To limit the display, click "Filter".

5. Enter a filter criterion in a column and click . Click  with "From" and "To" to enter a 
required period of time. Then click .

6. To connect an individual archive, activate the desired archive in the "List of available 
archives". Click "Save".

7. To disconnect an individual archive, deactivate the desired archive in the "List of available 
archives". Click "Save".

8. You sort the list entries by clicking on one of the column headers.

Alternative Procedure
To connect archive backup files, you can also use the WinCC Archive Connector. For additional 
information, refer to "Connecting archives using the WinCC Archive Connector (Page 162)".
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Result
The required swapped-out WinCC archives are connected. If you connect signed archives, 
which have been changed after the swap, a message is output.

Connect archives using the WinCC Archive Connector

Introduction                     
You use the Archive Connector to reconnect swapped-out WinCC archives with an SQL Server.

The Archive Connector has the following functions:

● Manual Connection: Local databases are selected and connected to the local SQL Server.

● Manual disconnection: Connected databases are disconnected from the SQL Server.

● Automatic Connection: Local directories can be selected in which WinCC archives have 
been exported. After activation of monitoring, all archives added to the directory are 
automatically connected with the SQL Server.

 

  Note
Connected archives on changeable media

Before changing the media in the drive you need to disconnect the archives on this medium 
using the Archive Connector. After changing the medium, check in Archive Connector 
whether the archives are connected on the new medium.

 

Requirement
● The Archive Connector may only be operated using a local SQL Server and a WinCC/

DataMonitor license.

● Archive backup files are write-protected. Create a backup copy of the file before connecting 
and remove the write-protection of the copied archive backup file.

● The archive backup files are stored on a local drive.

● The directories in which the archive backup files are stored have been released.

● The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".
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Procedure
1. From the Windows Start menu choose "Start > SIMATIC > WinCC > WebNavigator Server 

> ArchiveConnector".

2. Click "Add" in the "Configuration" tab. The "New directory" dialog opens.

3. Navigate to the directory in which the archive backup files are stored.

4. Enter a unique symbolic name for the directory. The name should only contain characters 
permitted in the SQL syntax. You use the symbolic name for access via the DataMonitor 
client.

5. Click "OK". The directory is displayed on the "Configuration" tab.

6. If you activate the checkbox for a directory in the "Monitored" column, then all archives that 
are added to the directory from the time of activation are automatically connected to the 
SQL server.

7. Remove a selected directory again, if necessary. The archives in the directory must already 
be disconnected. The status of the archives of a directory can be verified on the "Connect/
disconnect archives" tab in the "Connected" column.
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8. Click on the "Connecting/disconnecting archives" tab. All archives of a selected directory 
are displayed on the "Connecting/disconnecting archives" tab.

9. Select a directory with archives either from the list of directories or by its symbolic name.

10.Select the required archive and click "Connect".

11.Disconnect the connection of a selected archive, if necessary.

Result
A connection is created and the required archive backup files are connected with the SQL 
Server.

The "Connecting/disconnecting archives" tab displays the connection status of each archive. 
"From" and "To" columns contain the archiving period in the local time zone.

The "Type" column contains the details for archive type:

● A - Alarm archive

● TF - Tag Logging Fast

● TS - Tag Logging Slow

If you connect signed archives, which have been changed after the swap, a message is output.
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4.4.2 Creating static process pictures for the Webcenter

Introduction         
In the picture administration you specify which pictures you need for the web part "Static 
process pictures". The process pictures cannot be operated.

The DataMonitor server creates copies of pictures in a cycle that can be set. The server makes 
the pictures available as static process pictures on the DataMonitor client. 

The following objects are not displayed in the web part "Static process pictures":

● Global Script Diagnostics Window

● WinCC Media Control

● WinCC Controls from migrated projects that have been created with versions prior to WinCC 
V7.0.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The WinCC pictures are published for web access. Additional information is available under 
"Publishing WinCC process pictures (Page 117)".

● The start page of the DataMonitor is open.

● The "Picture administration" tab is open. All published process pictures are listed.
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Procedure
1. Select the desired pictures.

– To select all pictures, activate the checkbox in the column header.

– To select individual pictures, activate the checkbox in front of the required picture.

2. To show only a part of the picture, specify the following:

– X position: Start positions in x direction in pixels

– Y position: Start positions in y direction in pixels

– Height: Height of the picture in pixels

– Width: Width of the picture in pixels

3. To output the time when the process picture was created by the DataMonitor server, 
activate "Stamp". The date and time are displayed in the picture.
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4. In order to change the update cycle, enter the desired value in "Update time interval". Select 
this cycle as large as possible. A cycle that is too small results in limited performance.

5. Click "Save".

Result
The DataMonitor server creates static process pictures from the selected pictures. You can 
configure the static process pictures in the web part "Static process pictures".

Deleting static process pictures
To delete static process pictures, select the checkbox "Delete graphic" for the selected picture 
name. Click "Save" to delete the static process picture or the copy. You can no longer configure 
the deleted process picture in the web part "Static process pictures".

Finding picture names or limiting display
Use a filter to find a picture name or limit the display to certain picture names.

When you click  with "Filter" the filter is shown above the table. Enter a picture name in the 
text field or click <Enter>. 

To hide the filter, click .

4.4.3 Creating layout template for Webcenter pages

Introduction         
You need a layout template to create a Webcenter page. Predefined layouts were installed 
during the installation. Additionally, you can create your own Layout Templates.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.
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Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating layout" tab.

3. Define the number of columns and the number of lines.

4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".

5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1. The modified view will be 
displayed.
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6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol 
in a table field to place the web parts vertically or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a Webcenter page. 

4.4.4 Creating Webcenter page

Introduction   
You create Webcenter pages in which you add web parts. The Webcenter pages are stored 
in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user 
group has the "Edit" or "Create" access rights. 
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Requirement
● The directory ""myPart"" is set up.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating page" tab.

3. Click on the desired layout template. The file name is displayed in the "Layout file" field.

4. Enter a name in the "Webcenter page" field, for example, ""My_Webcenter"".
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5. Select the directory in which the Webcenter page is stored. The selected directory is 
displayed in the field "Save WebCenter page as".

6. Click "Save".

Result
The Webcenter page "My_Webcenter" is created and saved.

See also
Inserting web parts to the Webcenter page (Page 172)

Configuring web parts within Webcenter pages  (Page 175)

WinCC/DataMonitor Documentation
4.4 Working with the Webcenter

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 171



4.4.5 Inserting web parts to the Webcenter page

Introduction       
You compile the contents of the Webcenter pages from the web parts. 

Requirement
● The directory ""myPart"" is set up.

● The Webcenter page "My_Webcenter" is stored in the directory.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Pages" on the start page.

2. Click on the "myPart" tab.

3. Click on the entry "My_Webcenter".
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4. To add web parts, click  at the top right corner of the page. The available web parts are 
listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms".
If you insert several web parts into a table field, the web parts are arranged horizontally or 
vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".

WinCC/DataMonitor Documentation
4.4 Working with the Webcenter

WinCC/DataMonitor
System Manual, 02/2013, A5E32316056-AA 173



Result
Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current 
compilation of the Webcenter page is displayed.

See also
Overview of Web Parts (Page 111)

Creating Webcenter page (Page 169)

Configuring web parts within Webcenter pages  (Page 175)
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4.4.6 Configuring web parts within Webcenter pages 

Introduction       
To display data from WinCC Runtime or an archive, you must configure the web parts.

Web part configuration         

Open the configuration dialog of the web part
Deleting the web part
Minimizing the web part
Maximizing the web part
Exporting the web part
Exporting the configuration of the web part as XML file

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The Webcenter page "My_Webcenter" is open.

● The WinCC project is in Runtime.
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Procedure
1. Click  in the required web part. The configuration dialog is opened.

2. Configure the web part:

– Displaying process values in a table (Page 180)

– Displaying process values in a diagram (Page 181)

– Displaying alarm hit list (Page 187)

– Displaying alarms in the alarm table (Page 183)

– Displaying statistics function for process values (Page 189)

3. To change the position of the web part, move the web part to the desired position with the 
mouse.
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See also
Creating Webcenter page (Page 169)

Inserting web parts to the Webcenter page (Page 172)

4.4.7 Deleting Webcenter pages and layout templates

Introduction       
You can delete layout templates and Webcenter pages that are no longer required.

Requirements - Deleting Layout Templates
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● The start page of the DataMonitor is open.

Requirements - Deleting Webcenter pages 
● The logged in user must have "Create" access rights for the directory, in which the page to 

be deleted is stored.

● The start page of the DataMonitor is open.
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Deleting layout templates
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Deleting layout" tab.

3. Delete the required layout files:

– To delete several layout files, activate the checkbox "Selection" for the files you want to 
delete. Click "Delete".

– To delete all layout files, click "Select All". Click "Delete".

– To delete individual layout files, click the respective "Delete" button in the "Action" 
column.

Result
The selected layout file is deleted. You can also delete the supplied layout files. Existing 
Webcenter pages that are using this layout template are not deleted. You cannot create new 
Webcenter pages with this layout.

Deleting Webcenter pages
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Deleting page" tab.

3. Activate the respective check box to mark the pages to be deleted.

4. Click on the "Delete" button.
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Result
The selected Webcenter pages are deleted. 
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4.5 Working with trends and alarms

4.5.1 Displaying process values in a table

Introduction         
Use "Trends & Alarms" to display archived process values in a table.

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Process Value Table" tab.
The Web part "Process Value Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.
The archive tags available via this connection will be displayed. 
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range". 

8. Specify the number of decimal points in the area "Representation of decimal points".

9. In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.

Result
The values of the archive tags and the quality code are output in the process value table. 
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If the manual entry of archive values is allowed during runtime, the modified or newly created 
values are identified as such. There is an "m" in a separate column to show a manual entry of 
the archive value.

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

4.5.2 Displaying process values in a diagram

Introduction         
Use "Trends & Alarms" to display archived process values in trends. 

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Trend (Process Values)" tab. The Web part "Trend (process values)" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed.
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2.
The archive tags are listed in the area "Current selection".

7. In the section "Current selection", you specify for the individual archive tag:

– Color of time axis and value axis

– Trend presentation type

8. In the section "Value axis editor", you can activate the automatic scaling for the different 
value axes or you can assign a minimum and maximum value to each axis.

9. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range".

10.In the section "Diagram settings", you define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

11.Activate the option "Show legend" to display the legend.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the archive tags. 

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Enlarge the presentation and diagram range left or right of the center line. 
Restore the original view.
Exporting values of the displayed diagrams in CSV format
Changing the settings of the Web part.

 

4.5.3 Displaying messages in the alarm table

Introduction         
Use "Trends & Alarms" to display alarms in an alarm table. 
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Alarm Table" tab.
The web part "Alarm Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.

8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The 
setting is necessary if you select a connection to swapped archives that include archives 
of several WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. 
Enter the filter condition for all columns in the "Extended Filter" field. 
For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages".
Click  to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The messages are output in a table.

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

See also
Alarm Log Column Names (Page 186)
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4.5.4 Alarm Log Column Names

Introduction     
You can select the alarm log columns while displaying alarms in "Trends & Alarms".

Overview of column names

Position Name Type Comments
1 MsgNo Integer 4 Bytes Message number
2 State Small Integer 2 Bytes Alarm Log Status
3 DateTime DateTime 8 Bytes Time stamp of message (Date/time without 

milliseconds) 
4 Ms Small Integer 2 Bytes Time stamp of message (milliseconds)
5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 PValueUsed Integer 4 Bytes Process Values used 
8 to 17 PValue1 to PValue10 Real 8 Bytes Numerical Process Value 1 to 10
18 to 27 PText1 to PText10 VarChar (255) Process Value Text 1 to 10
28 ComputerName VarChar (255) Computer Name
29 Application VarChar (255) Application Name
30 Comment VarChar (255) Comments
31 UserName VarChar (255) User Name
32 Counter Integer 4 Bytes Running Alarm Message Counter
33 TimeDiff Integer 4 Bytes Time difference to "Came in" status 
34 ClassName VarChar (255) Name of the alarm class
35 Type name VarChar (255) Name of the alarm type
36 Class Small Integer 2 Bytes Message class ID
37 Type Small Integer 2 Bytes Message type ID
38 to 47 Text1 to Text10 VarChar (255) Message Text 1 to 10
48 AG_NR Small Integer 2 Bytes Number of the PLC
49 CPU_NR Small Integer 2 Bytes Number of the CPU
50 CrComeFore Integer 4 Bytes Foreground Color for the "Came in" Status
51 CrComeBack Integer 4 Bytes Background Color for the "Came in" Status
52 CrGoFore Integer 4 Bytes Foreground Color for the "Went out" Status
53 CrGoBack Integer 4 Bytes Background Color for the "Went out" Status
54 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" Status
55 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" Status
56 LocaIID Integer 4 Bytes Location of the Alarm
57 Priority Integer 4 Bytes Priority
58 AP_type Integer 4 Bytes Loop-in alarm
59 AP_name VarChar (255) Loop-in-Alarm Function Name
60 AP_PAR VarChar (255) Loop-in-Alarm Screen
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Position Name Type Comments
61 InfoText VarChar (255) Info text
62 TxtCame VarChar (255) Text came in
63 TxtWent VarChar (255) Text went out
64 TxtCameNWent VarChar (255) Text came in and went out
65 TxtAck VarChar (255) Text acknowledged
66 AlarmTag Integer 4 Bytes Message tag
67 AckType Small Integer 2 Bytes Acknowledgment Type
68 Params Integer 4 Bytes Parameter

4.5.5 Displaying the hit list of messages

Introduction         
Use "Trends & Alarms" to display the hit list of alarms in a table.

 

 Note

The display of alarms in the hit list may take some time and may place a strong load on the 
CPU. A message is displayed in "Trends & Alarms" if the data volume is too high. 

Confirm this message to continue without changes. If you want to reduce the data volume, 
stop the process and change the filter criteria. 

 

Requirement
● Connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Select the "Hit list of the alarms" tab. The web part "Hit list of the alarms" is displayed.

3. Click . The configuration dialog of the web part opens.

4. Change the title in the "Title" field. Enter a short message in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period". With relative times, enter a negative value 
into the respective field. For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.
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8. Select the respective WinCC server with "Selection of WinCC server". The setting is 
necessary if you select a connection to swapped archives that include archives of several 
WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. Enter the filter condition for all 
columns in the "Extended Filter" field. For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.

Result
The analysis values for the alarms are displayed in a hit list.

The table includes configured data and statistical values, such as the frequency of the alarm.

If you move the mouse above the column header, an explanation is displayed in a tooltip. 

Operation:

 In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.
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Export alarms in CSV format.
Changing the settings of the web part.

4.5.6 Displaying statistics function for process values

Introduction       
Use "Trends & Alarms" to display the statistics functions for process values in a table. 

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Statistics functions for process values" tab. The web part "Statistics functions 
for process values" is displayed.

3. Click . The configuration dialog of the web part opens.

4. Change the title in the "Title" field. 
Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed. 
You can limit the number of tags displayed using the "Archive selection" and "Tag filter" 
fields.

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. For more information 
on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

8. For representation of the data set the following:

– Number of decimal places

– Aggregate selection: Define the analysis function for the process values.

9. In the "Table size" area, define the size of the display window. 
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.
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Result
Statistics functions for the selected process values were executed and output in the table.

If you move the mouse above the column header, the archive name and the tag name are 
displayed in a tooltip.

You can export the displayed table in CSV format using the  icon. 

To change the settings, click .
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4.6 Working with Excel Workbook

4.6.1 Configuring the Excel workbook

4.6.1.1 Applying data from WinCC project

Introduction     
You need the WinCC configuration data for the configuration of Excel workbooks. This means 
you apply the data from a local WinCC project during configuration in the "Excel Workbook 
Wizard" . 

Requirement
● Server computer

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook" is installed.

– The DataMonitor server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– If you are using Excel 2007, you are only permitted to use Excel files with the extensions 
"XLS, "XLSX, "XLSB", and "XLSM".

– If you also use Excel 2003, you will have to switch on the compatibility mode in Excel 
2007.

Procedure
1. Open an empty Excel workbook.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" field is 
shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The dialog "Add / delete tags" will open.
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Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports".

 

 Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/
320369/en (http://support.microsoft.com/kb/320369/en) 

 

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

4.6.1.2 Applying data from a configuration file

Introduction     
You can create reports without connection to the WinCC server.

Configuration steps:
● Create a configuration file on the server.

● Configure data access with the configuration file.

● You can also configure the data access of a dedicated Web server / WinCC client.
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Requirement
● Server computer

– The DataMonitor server is installed.

– The online tags of the WinCC project are part of one tag group or one structure type.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2003 SP3 or Office 2007 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– If you are using Excel 2007, you are only permitted to use Excel files with the extensions 
"XLS, "XLSX, "XLSB", and "XLSM".

– If you also use Excel 2003, you will have to switch on the compatibility mode in Excel 
2007.

Creating a configuration file on the server 
1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer.

Open the menu command "Export Configuration Data" in the shortcut menu.

2. Specify the data to be exported in the "Export configuration data" dialog. 
If you do not want to create the online tags in one tag group or one structure type, use the 
"Without structure (fast export)" option for the export.

3. Specify the path and the name of the XML file.

4. Click "Export". An XML file is generated.

5. If no Excel installation exists on the server, transfer the XML file to another computer, on 
which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file
1. Open an empty Excel workbook on the computer with Excel.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next".

3. Navigate to the desired XML file.

4. Click "Next". The dialog "Add / delete tags" will open.

Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports". 
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Configuring data access of a dedicated Web server / WinCC client via XML file
If you want to display the project data from a dedicated Web server / WinCC client in the Excel 
workbook, you need to observe the following when configuring the Excel workbook via an XML 
file:

● The XML file now includes the data of subordinate servers whose packages are located on 
the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor 
server / WinCC client can take several minutes, depending on the size of the package.

● This XML file must be available on the Excel configuration computer. Enter the server prefix 
when importing the configuration data in the "Excel Workbook Wizard".

● If you configure the data display in the Excel workbook on the WinCC client in the WinCC 
project, you do not have to specify a server prefix. The server prefix is automatically used 
when data is inserted from the package.

 

  Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you 

must also select "Chinese (PRC)" as the primary processing language in the "Microsoft 
Office Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/
kb/320369/en (http://support.microsoft.com/kb/320369/en) 

 

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

Publishing the Excel workbook (Page 84)

4.6.1.3 Configuring the display of tag values

Introduction       
This chapter describes how to configure the display of tag values.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete tags" is open.
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Procedure
1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
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5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

6. Enter the name and password of a WinCC user in the "Server setting" dialog.
To avoid an additional login during online display of process data, enable "Activate 
automatic login". 
Confirm your entries with "OK".

7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Tag properties" will be opened.

8. Set the properties for display in the table, for example, the update cycle or the display of 
time stamp and quality code.

9. To apply the set update cycle to all tags, activate "Save as default".
Settings in the areas "Display in sheet" and "Additional data" do not apply to all tags.
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10.Confirm your entries. If necessary, repeat the previous steps to display additional online 
tags. Multiple selection of tags is also possible in the tag list.

11.Click "Next" to display archive tags and alarms.
Additional information is available under "Configuring display of archive tags (Page 78)" 
and "Configuring display of alarms (Page 81)".

Result
The display of tag values is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text "OV" in tag values stands for online tags. In the comments, the source of the 
displayed values is shown in the format "WDWO_<number>_<tagname>". 

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data.
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.
Tags with local computer updating are not supported

In multiple station projects, you can activate the "Computer-local update" option in the tag 
management for internal tags. Any change of the tags only has an effect on the local computer 
in this case. This function is not supported by Excel Workbooks.

 

 

See also
Publishing the Excel workbook (Page 84)

4.6.1.4 Configuring the display of archive tags

Introduction       
This chapter describes how to configure the display of archive tags.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete archive tags" is open.
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Procedure
1. Click  in the dialog "Add/delete archive tags".

2. The tag selection dialog opens.
Select the desired archive tag. 
Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
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4. Select the archive tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Archive tag properties" will be opened.

5. Define additional properties for display in the table, for example, data resolution or time 
window of the display.

6. If you select  the option "Display manually entered values", an additional column is 
displayed. You will then see the letter "m" if an archived value was manually entered during 
runtime.

7. To save the settings, enable "Save as default". The settings in the area "Additional data" 
are not saved.

 

  Note

If you use a user-defined data resolution with a combination of "Resolution" and "Quantity 
of data", it is possible that the amount of extracted data is not correctly determined. This 
results under certain circumstances in a mismatch between the displayed values and the 
configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value 
in the input field. Even values ensure a trend-true display.

 

8. Confirm your entries.
If necessary, repeat the previous steps to display additional archive tags. Multiple selection 
of tags is also possible in the tag list.

9. Click "Next" to display alarms. For more information, refer to "Configuring display of 
alarms (Page 81)".
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Result
The display of archive tag values is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text "AV" in tag values stands for archive tags. In the comments, the source of the 
displayed values is shown in the format "WDWA_<number>_<tagname>". 

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

 

 

See also
Publishing the Excel workbook (Page 84)

4.6.1.5 Configuring the display of alarms

Introduction       
This chapter describes how to configure the display of alarms.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete alarms" is open.
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Procedure 
1. Configure the alarms in the dialog "Add/delete alarms".

2. Select the required cell in the Excel table.
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3. Click . The dialog "Alarm - properties" will be opened.

4. Define the display options for alarms in the Excel table, such as headings and insertion 
sequence of attributes.

5. Enter a filter condition in the "Filter string" field or use the selection dialog to define a filter, 
for example, to display only specific alarms.

6. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 messages.

7. Activate the desired attributes in the list. For additional information, refer to "Alarm 
attributes (Page 207)".

8. To save the setting, enable "Save as default".

9. Confirm your entries.
If necessary, repeat the previous steps to display additional alarms. Multiple selection of 
alarms is also possible in the "Alarm list".

10.Click "Next". The "Description" dialog box will open.

11.You can enter a comment if needed. This comment is displayed when selecting files 
provided for download by the DataMonitor server.
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Result
The display of alarms is configured in the Excel workbook. 

Each table field receives a short text and a comment in the Excel workbook. 

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown 
in the format "WDWL_<number>_<fieldname>".

 

 Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

 

 

See also
Publishing the Excel workbook (Page 84)

4.6.1.6 Publishing the Excel workbook

Introduction
You make the configured Excel workbooks available on the DataMonitor client. The workbooks 
are published as report tool for the Intranet/Internet or used as template for "Reports". 

Requirement
● The DataMonitor server is installed on the computer.

● The display of tag values, archive values and alarms is configured.

● The "Description" dialog is open in the "Excel Workbook Wizard".
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Procedure
1. You make the workbooks available in the "Description" dialog.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under 
"Report tools" in "Reports".
If you click "Template", the Excel workbook is made available on the DataMonitor client as 
template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure
You upload the Excel workbooks on the DataMonitor client. Additional information is available 
under "Making Excel workbooks available as template (Page 210)" and "Making Excel 
workbooks available as report tool (Page 211)".
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Result
The Excel workbooks are made available on the DataMonitor client:

● The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. For more information, refer to "Displaying process data in an Excel 
workbook (Page 205)".

● You can create time-controlled and event-controlled reports using the workbook as 
template. For more information, refer to "Creating reports with an Excel workbook 
(Page 214)".

See also
Configuring the display of tag values (Page 75)

Configuring the display of archive tags (Page 78)

Configuring the display of alarms (Page 81)

4.6.2 Displaying process data in an Excel workbook

Introduction       
You can display process values or archive values and alarms in an available Excel workbook. 
You can edit and save the workbook.

Requirement
● The Excel workbooks were made available as report tool.

● MS Excel for online display in the Excel workbook

● The DataMonitor server is installed.

● The WinCC project is in Runtime.

● The start page of the DataMonitor is open.

● A user is created in WinCC.
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Procedure
1. Click "Reports" on the start page.

2. Click "Report tools".
You see the Excel workbooks that you have published in the Excel Workbook Wizard or 
made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed 
in the "WinCC server" field.
The "WinCC Server" field can include the following information:

– Access via domain: The server name and the domain are listed for access outside the 
network domain.

– The DataMonitor start page is the default web page: The "WinCC Server" field contains 
only the server name.

– The DataMonitor start page is in the virtual folder: The server name and the name of 
the virtual folder are displayed, e.g. "/webnavigator".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values 
of all servers are updated in the online display.

 

  Note

To establish connections to all servers, activate "all servers" with "Connect" before you 
establish the connections.

 

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened.
Type in the user name and associated password. 
In case of several servers, the log-in dialogs of the respective servers open one after the 
other.
If a connection was not established, a corresponding alarm is displayed. Clicking on the 
dialog will display additional information about the error that has occurred.

 

  Note

Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection 
establishment to the server is still open.
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10.The connection status will be displayed in the dialog.
Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the 
respective values or displays.

11.Activate the check box "Read cyclically" to update the tag values in cycles.

12.Close the "Excel Workbook" dialog after finishing your calculations in Excel.

13.Save the results in the workbook with the "Save as" menu command.

14.Close Excel.

Result
The process data are displayed in the Excel workbook and can be processed further.

See also
Administering users for DataMonitor (Page 127)

4.6.3 Alarm Attributes

Introduction     
When displaying alarms in "Excel Workbook"  you can select the attributes to be displayed in 
the table in the "Excel Workbook Wizard" .

Overview 

Position Attribute Type Comments
1 Name of the alarm class VarChar (255)  
2 Name of the alarm type VarChar (255)  
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Position Attribute Type Comments
3 Foreground color Integer 4 Bytes  
4 Background color Integer 4 Bytes  
5 Flash color Integer 4 Bytes  
6 to 15 Message Text 1 to 10 VarChar (255)  
16 to 25 Process value 1 to 10 Real 8 Bytes Numerical Process Value 1 to 10
26 State VarChar (255) Status text
27 Info text VarChar (255)  
28 Message class ID Integer 4 Bytes  
29 Message type ID Integer 4 Bytes  
30 AS Number Small Integer 2 Bytes  
31 CPU Number Small Integer 2 Bytes  
32 Duration Integer 4 Bytes Time difference to "Came in" status
33 Alarm counter Integer 4 Bytes Consecutive alarm counter
34 Acknowledgment Status VarChar (255) Text of the acknowledgement status
35 Priority Integer 4 Bytes  
36 Application  Application with which the comment was created.
37 Computer VarChar (255) Computer on which the comment was created.
38 Users VarChar (255) User who created the comment.
39 Comments VarChar (255)  

4.6.4 VBA Functions of the Excel Workbook

VBA Functions of the Excel Workbook   
The following functions are available to you in an Excel workbook if you have generated an 
instance of the Excel workbook object using the 
"Application.COMAddIns.Item("ExcelWorkbook.Connect").Object":

● ShowDialog(0): 
Opens the "Excel Workbook" dialog with a normal size.

● ShowDialog(1): 
Opens the "Excel Workbook" dialog with a minimized size.

● ShowDialog(2): 
Opens the "Excel Workbook" dialog hidden.

● CloseDialog: 
Closes the "Excel Workbook" dialog.

● GetServerID(server name): 
Gets the ID of the WinCC server with a specified name, for example: "http://Local_PC".

● Connect(ServerID): 
Connects the specified WinCC server to the Excel workbooks. You can get the "ServerID" 
using the "GetServerID(server name)" function.
The "Excel Workbook" dialog must be opened before establishing a connection.
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● ConnectAll: 
Connects all WinCC servers to Excel workbooks. The "Excel Workbook" dialog must be 
opened before establishing a connection.

● Disconnect(ServerID): 
Disconnects the Excel workbook from the specified WinCC server.

● DisconnectAll: 
Disconnects the Excel workbook from all WinCC servers.

● ReadTags(ServerID): 
Reads the tags from WinCC server with "ServerID". The connection must be established 
before tags can be read.

● ReadArchives(ServerID): 
Reads the archives from WinCC server with "ServerID". The connection must be 
established before archives can be read.

● ReadAlarms(ServerID): 
Reads the alarms from the WinCC server with "ServerID". The connection must be 
established before alarms can be read.

As soon as a connection is established or closed, the event "ServerConnected(ServerID)" or 
"ServerDisconnected(ServerID)" is output by the "ExcelWorkbook.Connect" object. These 
events can be integrated, for example, using "WithEvents" (VB standard).
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4.7 Working with reports

4.7.1 Making an Excel workbook available as template

Introduction     
You can make Excel workbooks available as templates to create ""Reports"". For this you have 
the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Template" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.

5. Click the "Upload" button.
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Result
You can create time-controlled and event-controlled reports using the workbook as template. 

See also
Assigning Access Rights (Page 152)

Configuring the Excel workbook (Page 71)

Displaying a report with an Excel Workbook (Page 214)

4.7.2 Making an Excel workbook available as a report tool

Introduction     
You can make Excel workbooks centrally available as report tools in "Reports". For this you 
have the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Publish" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

Here you find a description of how you make an Excel workbook not yet published available 
on the DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel 
workbook.

4. Click the "Upload" button.

Result
The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. 

See also
Displaying process data in an Excel workbook (Page 205)

4.7.3 Making Settings for Reports

Introduction           
Different settings are required for using the "Reports" function in DataMonitor. 

Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.
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● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Settings" tab. The "Settings" page is displayed.

3. Check the entries in the section "General project settings".
You can now select the printer of the Web server. Printing is only possible in files.

4. To enable the output to a PDF file, activate the option "Activate API print".
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5. Enter the data for sending mail in the "Mail" area:

– Server: Outgoing mail server (SMTP)

– User name: Name for the sender

– Password

– Sender: E-mail account used to sending the e-mail

6. Click the disk icon in the section "General project settings" to save your settings.

7. In the "Settings of the circular buffer" area, you can define the number of created reports 
that are stored in the selected destination directory. The field has a pre-assigned value of 
20. When the maximum number of reports has been reached, the first in, first out principle 
applies. 

8. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have been made.

Product support - example
FAQ "51334611" on the Internet under "Product support" gives a detailed example:

● http://support.automation.siemens.com/WW/view/en/51334611 (http://
support.automation.siemens.com/WW/view/de/51334611)

See also
Sending WinCC/DataMonitor reports by e-mail (http://support.automation.siemens.com/WW/
view/de/51334611)

4.7.4 Displaying a report with an Excel Workbook

Introduction     
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports from Excel workbooks. 

Requirement
● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● You have already published or made available as templates the Excel workbooks you want 
to use.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click on the "Excel Workbooks" tab. The "Excel Workbooks" page is displayed.

The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled 
Excel workbooks" are deactivated. The icons indicate that no reports are currently 
configured.

3. Select one of the available Excel workbooks under "Available Excel workbooks".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel 
workbooks" area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".
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9. Click "Add" in the "Time-controlled Excel workbooks" area. The report is displayed in the 
"List of time-controlled Excel workbooks".

10.To configure an event-controlled report, enter the following in the "Event-controlled Excel 
workbooks" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Event-controlled Excel workbooks" area. The report is displayed in the 
"List of event-controlled Excel workbooks".

Result
A time-controlled or event-controlled report is configured as "Excel Workbook". 

The configured reports are displayed in the lists of the "Excel Workbooks" . You can edit or 
delete the reports in the lists. 

Once the report has been created, it is available in runtime on the "Published Reports" tab in 
the selected directory. 

 

 Note
Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater 
than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often 
occurs, for example, with frequent signal changes of a tag that trigger an event-controlled 
report.

 

See also
Making an Excel workbook available as template (Page 210)

Publishing the Excel workbook (Page 84)

4.7.5 Creating a report with a print job

Introduction     
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports using print jobs in PDF format. 
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Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Print jobs" tab. The "Print jobs configuration" page is displayed.

The icons in front of "List of time-controlled print jobs" and "List of event-controlled print 
jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.
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8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" 
area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
time-controlled print jobs".

10.To configure an event-controlled report, enter the following in the "Event-controlled print 
jobs" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
event-controlled print jobs".

Result
A time-controlled or event-controlled report is configured as print job in PDF format. 

The configured reports are displayed in the lists of the print jobs. You can edit or delete the 
reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC 
Runtime language does not have an effect on the representation of dynamic elements, such 
as tables.

Once the report has been created, the PDF files are available in runtime on the "Published 
Reports" tab in the selected directory.

 

 Note
Opening Asian PDF files with Acrobat Reader

To open the Asian PDF files created with "Reports", you need the country-specific version or 
the respective font package of the Adobe Acrobat Reader.

The four Asian languages are fixed to one font each. This means the font settings in the report 
layout will not have an effect on the Asian languages.
Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is 
greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled print jobs over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often 
occurs, for example, with frequent signal changes of a tag that trigger an event-controlled 
print job.
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P
PDF file, 88, 114
PdlPad, 45, 120
Process picture

Publishing, 45, 117, 119, 120
Process value

Display in diagram, 65, 181
Displaying in a table, 64, 180
Displaying Statistics Function, 189

Published reports
Excel templates, 89, 210

R
Remote publishing, 45, 117, 119, 120
Report, (Siehe reports), (Siehe reports)
Report tool

Make available, 91, 211
Report tools, 86, 205
Reports, 88, 92, 94, 96, 114, 212, 214, 216

As e-mail, 92, 212
Excel workbook, 94, 214
PDF file, 88, 114
PDF Report, 92, 212
Print job, 96, 216

Settings, 92, 212
XLS file, 88, 114

Requirement
Hardware, 7
Installation, 7
Operating system, 7
Software, 7

Rights
Access right to directories, 152, 155
Access Rights in WinCC, 35, 127
Access Rights in Windows, 33, 34, 139
User Rights in WinCC, 35, 127
User Rights in Windows, 33, 34, 139

S
Security settings

Internet Explorer, 53, 141
SIMATIC Report Administrators, 33, 139, 150
SIMATIC Report Users, 33, 139, 150
Software

Requirement, 7
Statistics function

Displaying for process values, 189
Support, 26, 29
Support Request, 29
Swapped-out WinCC archive

Changeable media, 158, 162
connect to SQL server, 158, 162

T
Table

Displaying process values, 64, 180
Technical support, (See support)
Trends and alarms, (See Trends and Alarms)
Trends and Alarms, 64, 65, 112, 180, 181

Alarm Table, 67, 183
Analysis function, 187, 189
Column names of alarms, 186
Display function, 64, 65, 180, 181
Display Messages, 67, 183
Hit list of alarms, 187

U
User

create, 34, 139
User administration

Web center, 150
User change, 57, 145
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User group, 150
Automatically created groups, 33, 139
Individual groups, 33, 139

W
Web center, 99, 110

Access right to directories, 152
Layout template, 101, 167, 177
Linking and disconnecting archives, 158
Static process pictures, 165
Template file, 101, 167
User administration, 150

Web center page
Delete, 177
Inserting web parts, 106, 172

Web Configurator
 Configuring the Firewall, 40, 44, 134, 138

Web part, 106, 172, 175
Configuring, 175
Delete, 175
Export, 175
Inserting in Webcenter page, 106, 172
Minimize, 175
Moving, 175
Overview, 99, 111

Web parts, 99, 110, (See web part), (See web part)
Web project

Checking scripts with PdlPad, 45, 120
Publishing process pictures , 45, 117, 119, 120
Web Viewer, 57, 145

Web Publishing Wizard, (See WebPublisher)
Web View Publisher, (See WebPublisher)
Web Viewer, 57, 61, 145, 149
Webcenter page

Create, 103, 169
Creating directory, 152
Displaying data, 175
Template file, 101, 167

WebConfigurator
Configuring the Settings, 37, 131

WebNavigator
Publishing process pictures , 45, 117, 119, 120

WebNavigator Server
Checking scripts with PdlPad, 45, 120

WebPublisher
Checking scripts with PdlPad, 45, 120
Publishing Data, 129, 165
Publishing process pictures, 45, 117, 120
Publishing Process Pictures, 129, 165
Requirements, 119

WebPublishing Assistant, 129, 165

WinCC Archive Connector, (See Archive Connector)
WinCC DataMonitor, (See DataMonitor), (See 
DataMonitor), (See DataMonitor)
WinCC DataMonitor client, (See DataMonitor client)
WinCC DataMonitor server, (See DataMonitor 
Server)
WinCCViewerRT, 57, 61, 110, 145, 149, (See Web 
Viewer), (See Web Viewer), (See Web Viewer), (See 
Web Viewer)

Displaying pictures, 110

X
XML file

Creating, 73, 192
Memory location, 73, 192
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